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Preface 
 

This text was written for students seeking to lead community organizations.  The primary purpose was 

to provide a short text for a crash course in statistics for people working urban, non-profit 

environments.  The course is taught in Los Angeles, so the examples are largely from Southern 

California. 

The language is purposefully informal and avoids excessive statistical jargon.  

This is not a book for statisticians.  It fails, purposefully, to fully address many of the footnotes and 

caveats that mark rigorous statistical testing.  Instead, this text paints with broad strokes in an effort to 

bring readers up-to-speed on the basics of data analysis. 

People who read this text and complete the exercises in it should be able to speak with consultants, 

grant agents, the media, and the public confidently about their community using terminology that 

describes both the community and the dynamics that create conditions that affect urban communities. 

 

The text is divided into four parts:  

1. Gathering and processing quantitative data about urban environments. 

2. Measuring and describing communities. 

3. Characterizing difference, need and change in communities. 

4. Measuring the association among urban characteristics as well as cause-and-effect. 
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Chapter 1: Basic Data Needs for Community Organizations 

Introduction 
The pandemic of 2020-21 was a tragedy on many fronts. Among the many tragedies was the 

simultaneous erosion of many community organizations’ fundraising and operational capabilities while 

the needs of most communities increased, sometimes dramatically. In recent years, nonprofits and 

community organizations have been squeezed in unprecedented fashion. Changes in tax laws and 

economic volatility have made it harder to secure donations and made the competition for grant 

funding intense. Therefore, the need to be efficient has never been greater. Efficiency is necessary for 

managing donor funds and grants. Efficiency is necessary for managing staff, volunteers, payroll, and 

budgets. Perhaps most important, efficiency is necessary to make change. Program delivery and mission 

outcomes must be monitored, measured, analyzed, and communicated efficiently. To know if your 

organization is efficient, data and data analysis are necessary. 

Goal 
This manuscript does not provide advice or assistance on how to accomplish all these goals, rather the 

purpose of this textbook/lab manual is to: 1) provide some guidance on why community leaders should 

be at least minimally competent with data and data analysis; 2) provide a basic introduction to basic 

statistical measures and techniques that are commonly used to describe and differentiate communities, 

as well common measures of description, association, cause, and effect; 3) provide a basic introduction 

to easily accessible software tools used to gather, analyze and disseminate data about your community; 

4) point you to some of the more useful public datasets so that you may explore community data on 

your own. 

Need for Quantitative Data 
In the first exercise, you will be introduced to common sources of community data. The purpose of this 

exercise is to ensure students in this course know where to find data about communities of interest. It is 

the first step in describing your community of interest. While it might seem overly basic, description is 

fundamental to many organizations’ ability to convince stakeholders, donors, and grant agencies that 

there are, in fact, needs to be met in a community. Funding agencies frequently insist that applicants 

provide a detailed accounting of community characteristics. Grant agencies do this to ensure that 

funding is essential, and since funding decisions often pit competing claims of need by multiple 

organizations against one another, quantitative need metrics are often employed to establish the most 

deserving applications. In addition, funding agencies often want quantitative measures of the capacity 

for change, not only within your organization but within the community. An accounting of resources is 

often as prominent in applications for grants (and funding pleas) as those detailing community needs. 

Finally, funding agencies, donors, and organizations want to know if the delivered programs are 

effective. That requires attention to measure of cause and effect; not only because to influence change, 

you need to understand what factors create distress in neighborhoods; but also, if you attempt to apply 

remedies – you want to be able to measure success and/or failure in an honest way. 

Gathering Community Data  
Describing your community requires data. There are lots of kinds of data, but this manual focuses on the 

collection and analysis of quantitative data. The following exercises use a largely geographic definition 
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of community. Clearly, there are lots of ways people form communities and your community may be 

geographically scattered, or even digital. So, the data sources may not be perfectly suited to your needs, 

but hopefully, the tools for describing, differentiating, and understanding your community will be 

obvious to you as you work through the assignments. 

Census Data 
The most robust and widely used of all community data sources is that provided by the United States 

Census Bureau. They collect an enormous amount of data on people living in the United States each 

year and that becomes part of the American Community Survey (ACS). The ACS data is great because it is 

usually the most current. However, since it is sent to only about 3.5 million randomly chosen addresses 

per year, it is not always sufficient for community or neighborhood level analyses. For most years, ACS 

data is reliable only for county and state-level analyses. There are also “5-year ACS estimates” as well, 

and they contain data at the census block group. However, the ‘margin of error’ of these estimates is 

sometimes uncomfortably large and should be used with caution. 

Every 10 years, the Census Bureau conducts the Decennial Census (“THE Census”) and they make every 

effort to count all persons in the United States, including the homeless and non-citizens. However, 

counting non-citizens and the unhoused is difficult. Some politicians seek an undercount of the 

undocumented and unhoused to selectively weaken representation, funding, and political power to 

some locations. 

The Census releases data aggregated at various scales of resolution. The census block is the smallest 

unit, often simply a city block in urban areas, but the Census only provides minimal data (number of 

persons, e.g.) at the block level. Census block groups are the smallest geographic unit (600-3000 people) 

for which the Census releases detailed data. Block groups contain anywhere from 10 to 60 census 

blocks. Block group boundaries often coincide with major streets or other natural boundaries. Block 

group data is not always available before 1990. The data you can get at the block group level includes 

data on income, ancestry, citizenship, educational attainment, language, migration, disability, 

employment, and housing status. The census tract is the next largest scale or unit of analysis This data is 

widely available going back 40 years at least. Tract boundaries often coincide with city boundaries, or in 

large cities, things like major highways, or industrial zones. You can also get data at the ZIP code level, 

but it tends to be a bit problematic since ZIP code boundaries and Census boundaries are not aligned. 

Economic and business data (number of supermarkets, e.g.) is collected by the Census at the ZIP code 

level, and it can be quite useful if used carefully. 

After that, then there are other less well-known levels in which the census aggregates data, like 

counties, and subdivisions of very populated counties, called County Divisions (e.g., “San Fernando 

Valley”). Cities, villages, and towns make up a scale of analysis called Census Designated Place (e.g., “San 

Fernando”). Large combinations of cities and their surrounding suburbs are called Metropolitan 

Statistical Areas (e.g. Los Angeles-Long Beach-Anaheim); and the biggest combination of adjacent urban 

areas (based on commuting patterns) are the Combined Statistical Areas (e.g. LA-Ventura-Orange 

County, Riverside, etc.). The Census collects data at the congressional district, county, and state levels as 

well.  

You should know what choices you have as you seek to delineate and define your community or 

neighborhood of interest, and what your choices are for a backdrop against which you might compare 

https://en.wikipedia.org/wiki/American_Community_Survey
https://en.wikipedia.org/wiki/Census_block_group
https://en.wikipedia.org/wiki/United_States_Census
https://en.wikipedia.org/wiki/Census_block
https://en.wikipedia.org/wiki/Census_block_group
https://en.wikipedia.org/wiki/Census_tract
https://en.wikipedia.org/wiki/Census_county_division
https://en.wikipedia.org/wiki/Census-designated_place
https://en.wikipedia.org/wiki/Metropolitan_statistical_area
https://en.wikipedia.org/wiki/Metropolitan_statistical_area
https://en.wikipedia.org/wiki/Combined_statistical_area


 
 

3 
 

your community. Absolute figures often do not tell the entire story. Relative data is generally preferable. 

For example, the median annual family income in a community might be $35,000. That might be about 

average in Appalachia, but in Los Angeles, that might be well below the county or citywide average, so 

you need data on both your community of interest and on some larger community as well to provide 

context.  

The US Census provides a lot of ready-made data for communities and at various levels, via various 

services, like their “Quick Facts” website. However, most of the data analysis needed by community 

activists seeking grants or those wanting to really understand specific neighborhoods requires 

downloading data from the census and putting it in a spreadsheet, graphs, and/or mapping applications.  

The first two exercises in this text will help guide you through the process of downloading data from the 

Census website and a public data hub. 

  

https://www.census.gov/quickfacts/losangelescountycalifornia
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Lab 1A 

Downloading Community Data from the US Census Website 
In this assignment, you will learn some techniques for gathering community data from the US Census 

website that you may use to analyze a community of interest. 

Student Learning Outcomes: 

• Students successfully download community data from US Census Bureau. 
• Students save and prepare data for use in software applications. 

Program Objectives 

• Help communities identify their core needs. 

• Research complex issues and recommend evidence-based solutions. 

At the completion of this exercise, students will be able to download data about their community from 

the US Census Bureau. Gathering data and calculating basic descriptive statistics is the first step in 

creating a data-rich organization. 

Download Ethnicity Data from the US Census  

1. Go to www.census.gov  

2. Click on “Explore Data”  

3. Click on “Go to data.census.gov”  

https://data.census.gov/cedsci/ 

4. Click “Advanced Search”  

5. Click on Geography from the Browse Filters options and select 

the following: 

a. Tract 

b. California 

c. Los Angeles County 

d. “All Census Tracts within Los Angeles County, California” 

6. Note the search bin at the bottom ribbon on the screen shows what you have selected so far. 

7. Click on Years in the Browse Filters options and select the following: 

a. 2010 

8. Click on Topics in the Browse Filters options and select the following: 

a. Race and Ethnicity 

b. From the Race and Ethnicity options, select “00 – All available races.” 

9. Click Search (lower right hand of the webpage) 

10. From the list of Tables, select (click) “Total Population” (Table B01003) – Year 2010 

11. Click on Download Table 

12. Select CSV (comma separated values) -and click “Download”. 

13. Click the Download button. 

14. Extract the data from the Zipped File. 

15. Open the downloaded file in Microsoft Excel (or similar software – but instructions are for Excel) 

Open only the largest of the three files zipped in the downloaded compressed file. 

For Credit: Consult with your instructor or learning management system. Your instructor will likely 

ask you to submit evidence of your ability to download data from the US Census Bureau.   

Figure 1: YouTube Tutorial: Downloading 
Data from the US Census (2021) - URL: 
https://youtu.be/6wQAAq754DQ  

http://www.census.gov/
https://data.census.gov/cedsci/
https://www.youtube.com/embed/6wQAAq754DQ?feature=oembed
https://youtu.be/6wQAAq754DQ
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Lab 1B: Downloading Data from the Los Angeles Police Department 
In this assignment, you will learn some techniques for gathering community data from the Los Angeles 

City Data Portal website. This data may be used to conduct analyses on communities of interest in Los 

Angeles. Many similar data portals are operated by various levels of government to provide 

transparency in public management and to bolster trust. 

Student Learning Outcomes: 

• Students successfully download community data from Los Angeles Data Portal. 
• Students save and prepare data for use in software applications. 
 

Program Objectives 

• Help communities identify their core needs. 

• Research complex issues and recommend evidence-based solutions 
 

At the completion of this exercise, students will be able to download data about their community from a 

valuable local data repository, later that data can be used to describe a community of interest with basic 

descriptive statistics. Gathering data and calculating basic descriptive statistics is the first step in 

creating a data-rich organization. 

Introduction and Background 

At the completion of this set of introductory exercises, students will be able to download data about 

their community from a local data source. The Los Angeles City Data Portal is an immensely valuable 

resource for community-level data. Los Angeles County’s data portal is also very useful for community 

activists and researchers. There are similar data portals in many locations that have the resources to 

maintain a community data portal.  

Instructions: 

1. Point your browser to The Los Angeles City Data Portal   

(or use a search engine to find the page) 

2. Click on the Data Catalog link. 

3. Use the “Sort by” drop-down menu to select “Most 

Accessed”. 

4. From the list select “Arrest Data from 2010 to 2019” (Your 

instructor may have you select another data set) 

5. Note that the size of the file is too large for Microsoft Excel to 

open in a single worksheet. The row count is 1.32 million. 

6. Click on the View Data button. 

7. In the resultant web page click on the Filter button 

8. In the filter options click on the down arrow to the right of “Age” to change the filter to the 

drop-down option to switch from “Age” to “Arrest Date”  

9. Select from the Arrest Date options for one year span of your choice (2010 to 2019). 

10. The “is between” option will permit you to select Jan 1 (year) and Dec 31 of the same or another 

subsequent year. For example, Jan 1, 2012 to December 31, 2012. 

11. Check the box to the left of your date filter to activate the filter. 

Figure 2: YouTube Tutorial - Downloading 
LAPD Data from the L.A. Data Portal.  
URL: https://youtu.be/JR0KB0gilD4 

https://data.lacity.org/
https://data.lacounty.gov/
https://data.lacity.org/
https://www.youtube.com/embed/JR0KB0gilD4?feature=oembed
https://youtu.be/JR0KB0gilD4
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12. You may experiment with additional filters if you would like. Note the total number of rows of 

data is evident in the lower right corner of the table window. 

13. Click on the Export button.  If your internet connection is slow, reduce the number of months. 

Expect the file to be around 50,000 KB or 50 MB. 

14. From the Download options, select CSV for Excel (note the other options!) – the data will appear 

in the download window of your device. 

15. Open the file in Microsoft Excel.  

16. Save the file with a name like, "LAPD_arrests_2019.xlsx"  

a. It’s important to save it as an xlsx file so the pivot table will remain! 

17. Click somewhere on the data – any cell will do. 

18. Click on the Insert tab and then click on the Pivot Table button. 

19. Click OK to put the pivot table in a new worksheet ply (the default option). 

20. A new sheet will appear “Sheet 1.” 

21. In the Pivot Table Fields box, click-and-drag “Area Name” to the “Rows” box at the bottom. 

22. Click-and-drag “Charge Group Description” to the “Columns” box. 

23. Click-and-drag “Charge Group Description” to the “Values” box. 

24. You now have a count of arrests by crime types and LAPD Divisions. 

25. If you would like, you can filter the columns by clicking the down arrow to the right of the words 

“Column Labels” in cell B3 of the pivot table and selecting a subset of the data for inclusion in 

your pivot table. 

 

________________ 

For Credit: Consult with your instructor or learning management system. Your instructor will likely ask 

you to submit evidence of your ability to: 

1. Find, filter, and download data from a public data portal. 

2. Use a pivot table to do a basic data management task. 
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Chapter 2: Data Basics 
A quick introduction to different types of data is quite helpful as you start a crash course in data 

analysis. Remember, you don’t need to be a grand wizard at this subject, but you should know enough 

to discuss intelligently community data and to know what to ask for if you feel a need to hire a 

consultant to work with you on data analysis.  

Data Terminology 
The most basic element of quantitative analysis is data, and this comes in many forms. Most of what 

we’ll work with this semester is numeric data or groups of data we’ll call “data sets”. Most are 

government data that we will download and use in spreadsheet software– generally Microsoft Excel. 

Google has a program called Sheets that works almost identically. There are also database software 

programs that work similarly, like Microsoft Access and Power BI. The structure of the spreadsheet table 

helps clarify some of the additional terminology we need to learn as well.  

Examine the table below. Note that rows 2,3 and 4 contain observations or cases. The identifiers for the 

observations are in the two left-most columns (A and B). Observations could be states, cities, or 

neighborhoods, but they could also be individuals, groups, or schools.  

In spreadsheet (e.g., Excel) terminology, row 1 of a table (green cells) contains the column headers. This 

is a special row with information that should remain locked in row 1. In database software (e.g., Access), 

column headers are separate from the observation rows (yellow cells). If the table below were in 

database format, the column headers values in the cells of Row 2 (green), would be locked in the blue 

cells. This is important to know if you are downloading data or sharing data between spreadsheets and 

databases. They look the same but function differently. 

In the yellow cells are data values. The data value in Column B and row 2 is “Alabama”, therefore the cell 

reference is B2. Cell D4 has a value of 320000. Cell E3 had a data value of 29.4. 

Table 1: Sample Table 

 COLUMN A COLUMN B COLUMN C COLUMN D COLUMN E 

Row 1 Row - ID Variable 1 
(nominal) 

Variable 2 
(rank) 

Variable 3 
(discrete) 

Variable 4 
(ratio-percent) 

Row 2 Nominal – 01 Alabama 48 105000 10.4 

Row 3 Nominal – 02 Arizona 17 175000 29.4 

Row 4 Nominal – 06 California 1 320000 36.0 

Levels of Measurement 
There are different types, scales, or levels of data in the table above. Each type of data does different 

work. One type of data is nominal or “name” data. Obvious nominal data are things like, “Ventura” or 

“California” and “Oregon”. Less obvious nominal values include ZIP codes, FIPS (Federal Information 

Processing System) codes, and Census Tract IDs because they look like numeric data because they use 

digits, but they should be thought of as text or nominal data. The data in BOLD above is nominal data. 

Often software calls this type of data “string” or “text” data. Software generally forces nominal data to 

be left-justified in the cell. 

https://en.wikipedia.org/wiki/Nominal_category
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One of the important things to keep in mind is that for some statistical operations, there must not be a 

repeating value among nominal data. They must be mutually exclusive. Some software won’t let you 

perform certain analyses if you have a repeating “unique identifier” – or ID among your nominal data.  

A special kind of nominal data is labeled binary. It can be presented as “yes or no”; “on or off” “black or 

white” or “1 or 0”. Sometimes this is naturally occurring, but also it can be occasionally useful to convert 

other data types to binary or binomial format. For example, “above average or below average” can be 

created from a data set of income. 

Some data is ordinal. This means that it is ranked in some fashion. The data in italics in the table above is 

ranked data. Ranking could be with words like “Good, Better, Best”, or it could be numerical ranking, (1st 

place, 2nd and 3rd place). Ranked data might be placed in categories “Top 100 Hospitals”: “Top 200-300 

Hospitals”, etc. Data is ranked for various reasons. Sometimes, data comes to you in ranked format. 

Occasionally data is downgraded to rank format because certain statistics work better with ranked data 

than with the raw data. For example, you may want to find out if there’s a statistical correlation 

between two phenomena (race and income). If the data set you are working with has some extreme 

values (income), called outliers, and these outliers skew the data over much, then sometimes it’s 

advisable to rank the data and use a modified measure of correlation. Many math or statistical measures 

cannot use ordinal (ranked) data. 

Most statistical measures are performed on interval data or ratio data. Interval data has an arbitrary 

zero point – like zero degrees Fahrenheit. Ratio data has an absolute for zero, in which zero means 

“nothing”. It’s called ratio data because you can divide two ratio data values (like 50 people divided by 

250 people) and it makes sense. You can’t do that with interval data because zero is arbitrary. Most 

statistical tests require ratio data. 

There are two major sub-categories of data we will use in the ratio data family: discrete observations 

and rates/percentages. Discrete data is often available when we download or work with census data 

because it is about people, income, housing, etc. This is integer data – counting numbers – and cannot 

be divided into a smaller unit. There are no half or .34 people, etc. Discrete data is extremely useful, but 

often, it becomes more useful after it has been converted into a rate or a percentage because rates and 

percentages permit a different type of analytic comparison of datasets. Take, for example, crimes and 

crime rates. Large cities have more crimes than small villages because large cities have more people. 

Therefore, to compare the relative amount of crime between such places, the logical measure of relative 

crime levels is the crime rate. A rate crime rate is calculated by dividing the total number of crimes 

committed in a place by the population of the place. The result is then multiplied by some scaling factor, 

such as 10,000 or 1,000 to get crimes per population.  

The common variant of the rate is percentage. That is calculated by dividing the value of a subset of the 

whole and multiplying the result by 100. For example, to find the percent of black residents in a city, you 

would divide the number of black residents in the city by the entire population of the town, then 

multiply the result by 100.  

The important thing to remember about percentages is that in most cases, there is a maximum value of 

100. Later, when we learn about measures of association, like correlation and regression, we will need 

to be cautious when we compare discrete data against rates or percentages because to do so is a bit like 

“comparing apples and oranges.”  

https://en.wikipedia.org/wiki/Binary_data#Binary_variable
https://en.wikipedia.org/wiki/Ordinal_data
https://en.wikipedia.org/wiki/Ranking
https://en.wikipedia.org/wiki/Outlier
https://en.wikipedia.org/wiki/Level_of_measurement#Interval_scale
https://en.wikipedia.org/wiki/Level_of_measurement#Ratio_scale
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Lab 2A: Data Management with Pivot Tables and Census Data  
In this assignment, you will use the data that you downloaded in Lab 1A to help you learn more about 

the use of Pivot Tables. Pivot Tables are probably the most powerful, and popular tool within modern 

spreadsheet software because they permit you to rapidly organize large and often unruly datasets, 

perform many calculations, and even visualize data on the fly. 

Student Learning Objectives 

• Students successfully manipulate vertically arranged data using the pivot table function to 

produce a horizontally arranged table of data. 

• Students perform basic addition/subtraction using the formula tool in Excel. 

• Students prepare data for more advanced analysis or visualization. 

Program Objectives 

• Help communities identify their core needs. 

• Research complex issues and recommend evidence-based solutions. 

Instructions: 

1. Open the file that you completed for Lab 1A. It contained 

ethnicity data for 2010 in Los Angeles by Census Tract or use 

the link below. 

https://geographyplanet.org/..../lacnty_acs_tract_ethnicity_2010/ 

2. Familiarize yourself with the data contained in the file. 

3. Change the value in cell E2 to “Total”.  

4. Click on the “2” row identifier to the left of “id” in cell A2 to 

highlight all of row 2.  

5. Click on the Delete button on the Home toolbar to eliminate all the cells in row 2… 

6. (Optional) Sort the data by the values in column A. The fast way to do that is to click in cell A1 to 

activate it (“GeoID”) and then on the Home tool bar, click “Sort and Filter” and choose “Sort A-

Z” from the options. Note how some census tracts have far greater diversity than others. 

** Note that HISPANIC is a linguistic category and within that category, people may be the 

following: “White, Black, Asian, or other”. There are also some national identities as well. 

7. Click on the Insert Tab and from the Insert tool ribbon click on the Pivot Table button. 

8. Click OK on the “Create Pivot Table” dialog window that appears. Leave the default settings. 

9. A new worksheet (generally “Sheet 1”) will appear, and a blank pivot table appears. 

10. In the Pivot Table Fields window click-and-drag “GEO_ID” into the Rows box at the bottom. Note 

that a full list of all Census Tract IDs (GEO_IDS) appears in the pivot table. 

11. (optional) Click-and-drag GEO_ID to the Values box to see the relative measure of diversity 

populated in the spreadsheet to the right of the Census Tract IDs – those census tracts with a 

higher value have more categories of ethnic identity in them. REMOVE LATER!!! 

12. Click-and-drag “POPGROUP_TTL” (Population Group Title) into the Columns box. Note that it 

creates many columns of possible ethnic and racial identities in Los Angeles County 

13. Narrow the list of ethnic and racial identifications by clicking on the down arrow in the “Column 

Labels” cell (B3) and from the pop-up box, select only the following: 

a. Deselect “Select All” 

Figure 3: Video Tutorial: Using Pivot Tables 
to Convert Vertical Data to Horizontal 
Format. URL:https://youtu.be/c3YCuNbroZ0  

https://geographyplanet.org/..../lacnty_acs_tract_ethnicity_2010/
https://www.youtube.com/embed/c3YCuNbroZ0?feature=oembed
https://youtu.be/c3YCuNbroZ0
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b. “Asian Alone – Not Hispanic or Latino” 

c. “Black or African American Alone – Not Hispanic or Latino” 

d. “Hispanic or Latino (of any race)”  

e. “Total Population” 

f. “White Alone – Not Hispanic or Latino” 

14. Click-and-drag “Total Population” (or whatever you called the total population) into the Values 

box. Make sure the SUM shows in the pivot table.  

15. Note that the column “GRAND TOTAL” represents a double count. 

16. Click in the Pivot Table, and press “Control + A” at the same time to highlight and select the 

entire pivot table of data. 

17. Press Control + C to copy the entire pivot table (this puts everything highlighted in the 

‘clipboard’) 

18. Either press Control + N to open a new workbook, or just click on the plus sign at the bottom of 

your current spreadsheet to add a new worksheet ply. 

19. Put your cursor in cell A1 in the new worksheet. 

20. Click on the down arrow below the Paste button on the Home tool ribbon. 

21. Select from the options (click) “Paste Values” (the first one 123 is best) 

22. Click on the row one identifier to the right of cell A1, to highlight all of row 1. 

23. Click on the Delete button on the Home tool bar to delete all of Row 1. 

24. You may want to rename the column headers. 

25. Delete column G “Grand Total”. 

26. Press Control + A to highlight all the data. 

27. Press Control + H to bring up the “Find and Replace” dialog box. 

28. Leave the “Find what” option BLANK and enter 0 (zero) in the “Replace with:” box. 

29. Click on “Replace All” to replace all the blank cells IN THE TABLE ONLY with zeroes. 

30. Click OK. 

31. Highlight the column of data containing “all people” or “total” (click in the column header and 

press Ctrl+Shift+↓ simultaneously to highlight column) 

32. Press Ctrl+X (cut). 

33. Move the cursor to the first available blank column to the right – column G? 

34. In Cell E1 where “Total” was, enter “Other.” 

35. In cell E2 enter the following formula =G2-(B2+C2+D2+F2) and press enter. That will calculate 

the remaining people who do not fall into one of the ethnic categories we already have. 

36. Place your cursor back in cell E2 where the product of your calculation appears. 

37. Press Ctrl + C to highlight and prepare to copy. 

38. Double click in the lower right-hand corner of the highlighted cell to copy the formula to the rest 

of the column. 

39. Copy the new column and paste it back into the exact same space by clicking on Paste (down 

arrow) and selecting “Values” (paste as values) 

40. Save your work. 

41. You should have a file indicating the count of people by major ethnic categories throughout Los 

Angeles County by census tract. 

For Credit: Consult with your instructor. Your instructor will likely ask you to submit evidence of your 

ability to use a pivot table to prepare data for analysis.   
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Lab 2B-1: Using the VLOOKUP Technique to Combine Data Sets 
Background 

One of the biggest challenges associated with analyzing and visualizing community data is simply getting 

the data formatted so that it can be analyzed and/or visualized. This series of exercises and the 

accompanying videos provide instruction on several useful procedures for manipulating raw, untamed, 

unusable data. Helping you learn to format it so that is useful for analyzing and/or visualizing. 

These techniques are frequently necessary for researchers who seek to join data about communities or 

neighborhoods from disparate sources into a single dataset that can be used for both simple and 

advanced analyses.  These techniques are also necessary if you want to use a one-to-many and/or 

relational database (Oracle, Access, Power BI, etc.) to manage your data. 

In the first video tutorial you will learn to sort, concatenate, and convert numeric data to text or “string” 

data using the “text to columns” tool, all useful techniques for managing unruly or badly imported data. 

In this version of the tutorial, you will then use the VLOOKUP tool to join or merge two datasets into 

one.  

The VLOOKUP tool is a highly useful function in Excel well worth mastering. The function (formula) 

permits you to query (lookup) values in one dataset that exists in a second.  Once the match has been 

found, the software will return any values from the row with the matching identifier (ZIP code, etc.). The 

formula is simple if both datasets have a matching common identifier or join field.  

I made a second exercise and video, where you learn to do the same thing, but in that one, you will learn 

how to use Pivot Tables to combine two datasets into one using a common identifier. 

Instructions: 

1. Download and open the data file in Excel: 

https://geographyplanet.org/ca_lacnty_epa_census_join_data/  

2. Examine the data in the file. 

3. Note that there are two worksheets: “EPA Data” and 

“Census Data”.  

4. Note the common identifier we’ll use exists in column 

A in both worksheets (Census Tract) and the Census 

data (id) 

5. Click on the EPA tab to activate it. 

6. You may need to widen column A. 

7. Look at the EPA data in column A – under “Census 

Tract”. Note the data contains a series of numeric values beginning with the number 6. Also note 

that the data is right-justified in the column, which generally indicates that the cells are 

functioning as numeric values, rather than as text values. The value under ZIP is functioning the 

same way! THIS IS WRONG. Note that the data in the county column is left-justified as it should 

be.  ZIP and Census Tract data should be as well! 

8. To be sure this is the problem, highlight a few of the numbers in column A, and make note that 

at the bottom of the screen in the “status bar” several statistics appear, including “Sum”. That’s 

a foolproof way to test to see if cells have data functioning as numbers rather than text data. 

Figure 4: Video Tutorial - Using the VLOOKUP 
Tool to Join Two Datasets with a Common 
Identifier. URL: https://youtu.be/1FnL1ySufiw  

https://en.wikipedia.org/wiki/One-to-many_(data_model)
https://en.wikipedia.org/wiki/Relational_database
https://geographyplanet.org/ca_lacnty_epa_census_join_data/
https://www.youtube.com/embed/1FnL1ySufiw?feature=oembed
https://youtu.be/1FnL1ySufiw
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**What often happens while downloading data is that numeric identifiers, like ZIP Codes or 

Census Tract ID codes, get imported as numbers rather than text. This is a common problem. The 

main issue is that when this happens the leading zero is removed. So, in this case, the cells in this 

column that begins with 6 should begin with a zero – as in 06 –the US government code for 

California. It’s a big problem with ZIP codes in places like Boston where a ZIP might be 00013.  It 

will show up just as “13”. Besides, you should not be able to sum or get an average “ZIP Code”.  

Filter Data 

9. Next, filter the data from the EPA so you only have data from Los Angeles County by first clicking 

on cell B1 where the cell value is “California County.” 

10. Click on the Sort and Filter button on the Home tool bar. 

11. Select Filter 

12. Click on the down arrow in cell B1 and click to deselect “Select All”, then scroll down and click on 

“Los Angeles” to select only the rows of data that have “Los Angeles” in them. Click OK. 

13. Note that the only visible data is now from Los Angeles County. 

Copy Data to New Worksheet 

14. Click in the data and highlight the block of data (Ctrl+A). Copy the highlighted data (Ctrl+C). 

15. Click at the little plus sign at the bottom of the spreadsheet to add another worksheet ply. 

16. In the new worksheet “Sheet1” place your cursor in cell A1 and paste just the values. You should 

have only 2343 rows of data, plus a row of data headers (2344 total rows). 

17. Next, go to the Census Data worksheet, highlight, and copy all the data from the first 7 columns 

– columns A through F. 

18. Paste that in the newly created “Sheet1” into cell P1 (so you have four blank columns of data). 

19. Click on the column identifier Q (to highlight the entire column Q).  Click on the DELETE button 

on the Home toolbar to delete that entire column. *Don’t use the delete key on your keyboard! 

Use the Text to Column Tool  

20. Examine the values in column P below the word “id”.  Note that the digits to the left of the letter 

“S”.  You should see something like, “06037101110”.  That is a census tract identifier.  

a. Note that “06” = California and “037” = Los Angeles County. “101110” is the tract. 

21. That data is functioning as text (correct) because there are letters in the cell. 

22. Highlight the entire column below cell P1. 

23. Click on the Data tab and from the Data Toolbar click on the “Text to Columns” button. 

24. In the Text to Columns Wizard dialog box, Step 1, chose “Delimited”, click next. 

25. In the Text to Columns Wizard dialog box, Step 2, check the box to the left of “Other:” and type 

an “S” in the box to the right of “Other:”   

a. Note that a line separating the letter U and the numbers to the right appears in the Data 

Preview box. 

b. Click Next. 

26. In the Text to Columns Wizard dialog box, Step 3, notice the first column of data in the Data 

Preview window is highlighted in black.  Click on the “Do Not import column (skip)” option from 

the Column data format options. 

27. Click on the word “General” above the second column of data in the Data Preview window to 

highlight it, then click the “Text” option in the Column data format options. *THAT is a very, very 

useful technique for managing data!!!  Click Finish 
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28. Note the small green triangle in each of the data cells in column P.  That’s good.  It’s warning us 

that the data is functioning as text (even though it looks like numbers).  Exactly what we want! 

Use the Concatenate Tool to Convert EPA Census Tracts to Text Format 

29. Note once again that the data cells in column A are acting like numbers, not text. 

30. Rename column B “ID” (cell B1) 

31. Enter the following formula in cell B2:  =CONCAT(“0”,A2)   Press Enter. 

32. Copy and paste the formula you created in B2 to the rest of column B, replacing all instances of 

“Los Angles” with census tract IDs. 

33. Now highlight all the values in column B, copy and paste them in the same location, but only 

paste values to eliminate the formulas and leave us only with  

a. To paste only values, click on the Home tab, then from the Paste option (down arrow) 

select “Values” from the Paste Values options (or) 

b. Right-click and from the paste options, choose “Values” from the list. 

c. Note the little green triangles in the cells, warning us of the data acting as text. 

Use the VLOOKUP tool to join the Data. 

34. Click in cell L1 and enter “Total”. 

35. Click in cell M1 and enter “Hispanic”. 

36. Click in cell N1 and enter “NHWhite” (for Non-Hispanic White) 

37. In cell L2 enter the following formula: =VLOOKUP($B2,$P$2:$T$2347,2,false) 

38. In cell M2 enter the following formula: =VLOOKUP($B2,$P$2:$T$2347,3,false) 

39. In cell N2 enter the following formula: =VLOOKUP($B2,$P$2:$T$2347,4,false) 

40. Copy and paste the formulas in cells L2, M2, and N2 to the rest of the column so that each of the 

cells adjacent to the EPA data (on the left side of the worksheet) has ethnicity data. 

41. You MAY want to copy and paste the data you just pasted once again, back into the same cells, 

but as values. (or elsewhere if you want to have evidence of your formulas!) 

 

Data Sources: 

CalEnviroScreen: https://oehha.ca.gov/calenviroscreen  

US Census: https://data.census.gov/cedsci/  

_______________ 

For Credit: Consult with your instructor. Your instructor will likely ask you to submit evidence of your 

ability to combine data from two separate sources into a single analysis-ready dataset using the 

techniques and tools presented in the exercise. 

  

https://oehha.ca.gov/calenviroscreen
https://data.census.gov/cedsci/
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Lab 2B-2: Data Management Joining Data with a Pivot Table (Optional) 
Background 

One of the biggest challenges associated with analyzing and visualizing data about communities is simply 

getting the data formatted so that it can be analyzed and/or visualized. This exercise and the 

accompanying videos provide instruction on one of the useful procedures for manipulating raw, 

untamed, unusable data into a format that is useful for analyzing and/or visualizing. 

Student Learning Objectives 

• Students successfully manipulate vertically arranged data using the pivot table function to 

produce a horizontally arranged table of data. 

• Students perform basic addition/subtraction using the formula tool in Excel. 

• Students prepare data for more advanced analysis or visualization. 

Program Objectives 

• Help communities identify their core needs. 

• Research complex issues and recommend evidence-based solutions. 

In this pair of tutorials, you will learn to sort, concatenate, and convert numeric data to text or “string” 

data and then combine two sets of data into one using a Pivot Table. In this tutorial, you’ll learn how to 

use a Pivot Table to join data from two separate sources into a single useable dataset. This is a useful 

skill because it will allow you to combine data from different sources into a single useful file. 

Instructions:  

1. Download and open the data file in Excel: 

https://geographyplanet.org/ca_lacnty_epa_census_join_data/  

2. Examine the data in the file. 

3. Note that there are two worksheets: “EPA Data” and “Census 

Data”.  

Filter the EPA Data and Copy to New Sheet 

4. First, filter the data from the EPA that is not Los Angeles 

County by first clicking on cell B1 where the cell value is 

“California County.” 

5. Click on the Sort and Filter button on the Home tool bar. 

6. Select Filter 

7. Click on the down arrow in cell B1 and click to deselect “Select All”, then scroll down and click on 

“Los Angeles” to select only the rows of data that have “Los Angeles” in them. Click OK. 

8. Click in the data and highlight the block of data (Ctrl+A). Copy what you highlighted (Ctrl+C). 

9. Click at the little plus sign at the bottom of the spreadsheet to add another worksheet ply. 

10. In the new worksheet “Sheet1” place your cursor in cell A1. 

11. Paste (Ctrl+V) what you copied (as values if you’d like) into the new worksheet “Sheet 1”. 

Copy and Paste Census Data to New Sheet 

12. Click on the bottom tab “Census Data” to activate that worksheet. 

13. Highlight the data in columns A-G and copy it (Ctrl+C) 

Figure 5: YouTube Tutorial: Combining 
Data from Two Sources using Common 
Identifier with PIVOT Table. URL: 
https://youtu.be/bvxke5eFeaY  

https://geographyplanet.org/ca_lacnty_epa_census_join_data/
https://www.youtube.com/embed/bvxke5eFeaY?feature=oembed
https://youtu.be/bvxke5eFeaY
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14. Click on the Sheet 1 tab to reactivate that worksheet. 

15. Place your cursor in cell P1 of “Sheet 1” and paste what you copied from the Census. You must 

leave four or five rows of data between two blocks of data you pasted. 

16. What you should have in “Sheet 1” are two blocks of data that are not touching each other and 

separated by about four or five blank columns of data. 

Note the mismatched Census Tract ID numbers. 

17. Widen column A in Sheet 1.  Double click on the line separating A and B in the column headers. 

18. Look at the EPA data in column A – under “Census Tract”. Note the data contains a series of 

numeric values beginning with the number 6. Also note that the data is right-justified in the 

column, which generally indicates that the cells are functioning as numeric values, rather than as 

text values. The value under ZIP is functioning the same way! THIS IS WRONG. Note that the 

data in the county column is left-justified as it should be.  ZIP and Census Tract data should be as 

well! 

19. To be sure this is the problem, highlight a few of the values in column A, and make note that at 

the bottom of the screen in the “status bar” several statistics appear, including “Sum”. That’s a 

foolproof way to make sure values are functioning as numbers rather than text data. 

**What often happens while downloading data is that numeric identifiers, like ZIP Codes or 

Census Tract ID codes, get imported as numbers rather than text. This is a common problem. The 

main issue is that when this happens the leading zero is removed. So, in this case, the cells in this 

column that begins with 6 should begin with a zero – as in 06 –the US government code for 

California. It’s a big problem with ZIP codes in places like Boston where a ZIP might be 00013. 

Besides, you should not be able to sum or get an average “ZIP Code”.  

20. Now, widen the column P. Note that in the id column (P) of the Census data you pasted in 

columns P through V, there is a column of Census Tract IDs (column P “id”), but this time each 

Census Tract identifier is preceded by ‘140000US’. Everything before the letter “S” must be 

removed because to combine these two data sets the Census Tract IDs must match. 

Use the Concatenate Formula 

21. To make the “Census Tract” data from the EPA useful, you need to add a leading zero (0) and 

convert those cells to text format. Begin by renaming the column header “California Counties” 

(cell B1) to “TRACT ID1”. 

22. In cell B2, just under TRACT ID1, type in the concatenate formula which will combine two or 

more things into a single new data entry. The formula should be =CONCAT(“0”, A2) – that 

formula will add a leading zero to the value in cell A2. The result of the formula will be 

06037101110.   

*Note that the result of the formula in cell B2 is left justified, indicating that it is functioning like 

a text value, which is what we want! 

23. Highlight cell B2 and then press Ctrl+C to copy the formula you just entered, then paste it to the 

rest of the column replacing each instance of “Los Angeles” with the formula. You can double-

click in the lower right corner of cell B2 to accomplish the pasting task quickly. 

24. The column of pasted formulas should remain highlighted, but if it isn’t, highlight column B and 

paste it back to the same column, but as values. Copy and paste as values (click on the paste 

button down arrow and select “paste as values” from the options) 
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25. Note the little green triangles are in the upper left corner of each cell in column B, warning you 

that the data is acting like text, even though it looks like numbers. That’s good! 

Text to Columns 

26. Now you are going to use a different technique to convert the Census version of Tract IDs to 

match what you just created in Column B, by first renaming the value in column Q, “Geographic 

Area Name” to “TRACT ID2”, so it echoes what you typed in cell B1. 

27. Now, highlight the column of data below the column header ‘id’ – in cell P1 (or wherever you 

pasted it). To do that quickly, place your cursor in cell P2 and then press Ctrl+Shift+↓ (down 

arrow key) 

28. Copy it and paste it into cell Q2, so you have two identical columns of data. 

29. Click on the Data tab (make sure the values in column Q are still highlighted). 

30. Click on the Text to Column button to bring up that tool. 

31. In the Text to Columns Wizard, click on “Delimited” in Step 1, then click Next. 

32. In Step 2, deselect “Tab” and click in the “Other” box and type in the letter S in the box next to 

Other:  Then click Next. 

33. In Step 3, the first column of data is highlighted in the Data Preview window at the lower part of 

the dialog box, so click “Do not import column (skip)” 

34. Click on the word “General” above the second column of data and then select the “Text” option.  

**This is a very important step - and this technique is incredibly useful!! 

35. Click Finish and note the changes in column Q. There should be little green triangles in the cells 

warning you that the data is acting like text, even though it looks like numbers. That’s good! 

Move the Census Data below the EPA Data (Tricky! – the YouTube Tutorial is very useful here) 

36. Next highlight columns P – V of CENSUS data (Ctrl-A) and press Ctrl+X to “Cut” the data 

37. Place your cursor at the BOTTOM of column A (cell A2345) and paste the CENSUS data there, so 

that ALL the Census Tract IDs are in column B – both the EPA Data and the Census Data. 

38. Place your cursor in cell C2345 where the word “Total” is found. 

39. Highlight that cell and all those in the rows beneath it.  

40. Click on the Home tab and click on the Insert button.  Note the cells all move right one column. 

41. Click on Insert 8 more times until the values are in columns L-P (or you can move them with Ctrl 

X, Ctrl V) so the block of census data is just below and to the right of the EPA data. 

42. Move or copy the column headers (Total, Hispanic, NonHisp White, etc.) back to Row 1, directly 

above the columns containing the data corresponding to the column headers in Row1. 

43. Click on the row identifier 2345 to highlight that row of cells containing the old column headers 

so that there is no gap between the EPA data and the Census Data. 

44. Click on the Delete button on the Home Tab toolbar to eliminate that row. 

45. Now below and to the right of the EPA data in Cell L2345 you should have 5 columns of data and 

in row 1 above them (2344 rows above) in cells L1, M1, N1, O1, P1 you see “Total”, 

“Hispanic/Latino”, “Not Hispanic”, “Non Hisp White” and “Non Hisp Black”. 

Use the Pivot Table 

46. Next click somewhere in your data block (cell A1 is fine) 

47. Click on the Insert tab (top) and select from the Insert tool bar “Pivot Table” (on far left) 

48. Click OK on the pop-up dialog window to create a new sheet with a Pivot Table. A new sheet, 

“Sheet 2” will appear.  
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49. In the Pivot Table Fields window (right) click-and-drag “TRACT ID1” into the Rows window/box 

near the bottom. 

50. *Optional* drag the “TRACT ID1” again to the Values box – you should see 2, indicating that 

each TRACT ID is repeated twice in the column of data. 

51. Click on “Asthma” and drag it to the Values box. It MAY calculate the number of times (count) 

that a value of Asthma appears, or it may give you the “Sum of Asthma” SUM is what you want – 

it is the percent of persons with Asthma in that census tract. If COUNT appears, then click on the 

down arrow/triangle to the right of the word Asthma in the Values box and select “Value Field 

Settings” and change that to Sum (or average or min/max…it won’t matter because there’s only 

1 value) …for the first Tract ID it should be 43.41. 

52. Next, click “Hispanic/Latino” from the list of Fields and drag that into the Values Box. Make sure 

it’s set to SUM as well. You should see 1324 for the number of Hispanics/Latinos in that Tract. 

53. You should CHECK on your work by examining the values for this census tract in the original 

sheets containing the EPA and Census Data. 

54. Save your file. 

_______________ 

For Credit: Consult with your instructor. Your instructor will likely ask you to submit evidence of your 

ability to combine data from two separate sources into a single analysis-ready dataset using the pivot 

table technique. 
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Chapter 3: Descriptive Statistics 
Statistics, and mathematics in general, causes many people a lot of anxiety. Perhaps statistics freaks you 

out. It doesn’t have to be that way. The vast majority of what anyone needs to know for statistics 

involves only addition, subtraction, multiplication, and division – plus exponents and square roots, etc. 

This course will not focus on how to do the math. We will trust the software to do that for us. 

Instead, we need to know what statistics are useful and how we can use a handful of common statistics 

to the advantage of our organizations and our communities. We need to know when to use one statistic, 

and not another. For this chapter, we will focus on a few common descriptive statistics and just a bit of 

decoding of the jargon of statistics. Community leaders must know some of the language of statistics so 

they can work with those who are fluent in the language of statistics, and with donors and funding 

agencies requiring statistical measures of need and program success. 

Basic Measures: Mean, Mode, and Median 
There are multiple kinds of statistics, but the most well-known statistical measures are called descriptive 

statistics. First among these is the statistical average or mean. This statistic is the most common 

measure of central tendency. Mean is calculated by summing the values of some group of observations 

and dividing by the number or count of observations. The count of observations is often referred to 

simply as “N” when you have observed all, or the entire population, of concern. If your observations are 

from a sample of the population, then lower case ‘n’ is used instead. That rule on capitals and lower-

case abbreviations holds true in most statistical applications. You should also note that statisticians also 

often use Greek letters to refer to population attributes and Roman letters, often with some additional 

symbol, to refer to samples. So, for example, the lower-case Greek letter µ (mu) stands for the 

population mean, and �̅� (x bar) is the sample mean.  

Median is the second most common measure of central tendency. If you ordered all your observations 

from smallest to largest, the median would be the observation halfway between the largest and 

smallest. There are numerous instances where the median is a better measure of central tendency than 

the mean. Median is most frequently used as a substitute for mean when the data is badly skewed. 

Perhaps the most common such instance occurs in measures of income because measures of wealth are 

often wildly skewed by the outliers –millionaires and billionaires. In one exercise that accompanies this 

Figure 6: Graphic - Mean, Mode and Median – with skew. Source: Wikimedia. 

https://en.wikipedia.org/wiki/Outlier
https://commons.wikimedia.org/wiki/File:Relationship_between_mean_and_median_under_different_skewness.png
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chapter, you’ll use tax return data by ZIP code data and skewing will be obvious. The super-wealthy 

drive the mean upward and away from the center of the observations, skewing the data to the right 

(positive skew). In those cases, the median is a better measure of what is most “ordinary, common, or 

normal”. 

The mode is the most frequently repeated observation in a sample or a population. Unless you have a 

LOT of observations, there’s rarely a reason to use mode with community data. If you do have a lot of 

observations, a mode might point to some interesting phenomena or troublesome problems with the 

data collection. This is especially true if the mode does not generally align with the values of the mean 

and median.  

On the other hand, some datasets are considered 

bimodal or multi-modal because they have more than 

one grouping of similar values. For example, in large 

classes of freshmen, there is regularly a bi-modal 

distribution of grades. One set of students aims “just to 

pass” and another group works toward “getting an A”, 

so the grade distribution has two clusters, around a 

passing grade (58-62) and then around the lower bound 

for an A grade (88-92). See figure 7.  

Skew 
Above the expression “badly skewed” was mentioned. Consider for example, if NBA basketball legend 

Shaquille O’Neil joined your class. He would dramatically raise the mean height and weight of the class 

because he is an outlier, and his enormous height and weight would skew (positive or right skew) our 

distribution. We could measure his effect on the distribution by calculating the skewness of the data. A 

very small person might skew the data to the left (negative skew). 

In this course, we’ll let Excel calculate that for us and as a rule of thumb, any value for skewness that is 

beyond -1 or 1, we’ll consider “skewed” and any value beyond -3 or 3 we’ll consider “badly skewed”. In 

the Shaquille O’Neil example from above, if we had a class of 20 students and the mean height was 

about 68.7 inches (everyone within four inches of 69”) – when Shaq, at 86 inches joined the class, the 

mean would jump to 69.5, which doesn’t seem like a big difference, but the value for skewness would 

rise from around 0.10 to 3.15!  Therefore, the median would be better than the mean as a measure of 

central tendency once Shaq joined the class. 

Standard Deviation  
Closely tied to the idea of skewness is a measure that 

characterizes the spread of data around the mean called 

Standard Deviation. It might be easy to think of standard 

deviation as ‘the average of the average’. I like to use 

the value for standard deviation with the expression 

“give or take”. The statistic is useful for several 

purposes. It tells us how unusual outliers are and what is 

within the range of “normal” or “expected” based on our 

observations. 

Figure 7: Histogram with a Bimodal Distribution. Source: 
Wikimedia. 

Figure 8: Graphic - Standard Deviation viewed on a 
normal or 'bell curve'. Source: Wikimedia 

https://en.wikipedia.org/wiki/Outlier
https://commons.wikimedia.org/wiki/File:BimodalAnts.png
https://commons.wikimedia.org/wiki/File:Standard_deviation_diagram.svg
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Generally, in a large dataset, if it is normally distributed (like a bell curve) around 68% of all observations 

will fall within 1 standard deviation of the mean, about 95% of all observations fall within 2 standard 

deviations of the mean and about 99.7% of all observations fall within three standard deviations of the 

mean. It’s important to keep in mind that not all populations or data sets are normally distributed. 

Human height and weight tend to be normally distributed, so such populations are good examples. The 

mean height for men is 5’9” or 69 inches. The standard deviation is about 3 inches. So, if you had a 

random sample of American men, you’d find about 68% of them (68 out of 100) would be between 5’6” 

and 6’0”. 34% would be between 5’6” and 5’9”, or between 0 and -1 standard deviations of the mean. 

About 95% of American men are within 2 standard deviations of 5’9”, so a random sample of 100 would 

probably include about 95 men between 5’3” and 6’2.  From that random sample, we could expect 

about 1 man to be 5’2” or less, and 1 to be 6’3” or more. Shaquille O’Neil is about 7’2” tall, so he is 

about 6 standard deviations above average. Of the 100 million men in the United States, there are only 

about 20 people or so taller than that! 

Consider a class of 20 students with an average weight of 150 pounds. It could be that half the class 

weighs about 148 pounds and the other half weighs about 152 pounds. On the other hand, half the class 

could weigh around 100 pounds and the other half could weigh around 200 pounds. Standard deviation 

is a measure that helps characterize the differences in the spread (distribution) of values around the 

mean. In the first example, the standard deviation would be around 2 -because the class is crowded 

around the mean. In the second scenario, the standard deviation is 50, indicating that the average isn’t 

very ‘average’ – the observations are spread out – it’s a bimodal distribution. In plain English, you might 

say of the first scenario, “The class weighs on average 150 pounds, give or take 2 pounds”. For the 

second scenario, you might say, “The class weighs on average 150 pounds, give or take 50 pounds”. If 

the heaviest human ever (at 1000 pounds) joined that same class, he would badly skew the data, and 

the standard deviation would just about equal the average! So, you would say, “The class weighs on 

average 190 pounds, give or take 190 pounds”. The mean in such scenarios becomes almost 

meaningless, so you would use the median because it would likely remain at around 150 pounds. 

You could also use a statistic called kurtosis. You’ll probably 

encounter it in the exercises for this class. Kurtosis is another 

measure of how crowded observations around the mean. It’s 

best observed in the graphics (bell curves and histograms) 

that you will calculate. Skinny, tall bell curves are said to be 

leptokurtic, and they’ll have small standard deviations 

relative to the mean. Wide, low bell curves are said to be 

platykurtic, and they’ll have a large standard deviation 

relative to the mean.  

Percentiles and Z-Score 
There are multiple useful ways to characterize a community or individual using the bell curve. Percentile 

is a measure that places an observation (community, e.g.) along a continuum between 0 and 100 based 

on its position relative to the other observations. Percentile is commonly used by pediatricians to 

describe children in terms of height and weight compared to others of the same age. So, an observation 

that is at the 57th percentile would be the 57th largest if there were 100 observations. Conversely, an 

observation at the 0 percentile would be the smallest among a group of 100. An observation at around 

Figure 9: Three curves showing varying levels of 
kurtosis: Platykurtic, Normal and Leptokurtic. 

https://en.wikipedia.org/wiki/Percentile


 
 

21 
 

50, should be reasonably close to the average, and so on. Conversion of skewed data to percentile is 

another means of normalizing the data so that comparisons to other data sets and observations can be 

made. In other words, to normalize data is to convert it to a scale that can be used for comparisons. The 

major weakness and the major strength of converting data to percentiles are that percentiles hide 

outliers in the data. 

Z-Score 
Another common data conversion technique involves 

converting data to use on a standardized scale by converting 

each observation to a z-score. Z-Scores work similarly to 

percentiles, but instead of simply ranking observations 

against one another on a scale of 0 to 100, a Z-Score puts 

observations into context by comparing the value against the 

average and standard deviation. Z-Scores are a little less 

transparent to the untrained, but they are more useful to 

those with a bit of knowledge of statistics.  

A standardized score or Z score tells you how many standard 

deviations above or below average any observation is in a 

data set. A value that is average or equals the statistical mean will have a Z score of zero. Typically, any 

value that is less than -1.96 or above +1.96 is considered “unusual” in lay persons’ terminology. That’s 

because less than 2 percent of observations will be above and below those parameters. In other words, 

if we weighed 100 people in a room, and we calculated the Z score for every person’s weight, then we 

could expect only 2 people to be below -1.96 standard deviations for weight and only about 2 people to 

be above +1.96 standard deviations. 1.96 is a kind of ‘magic number’ in statistics and it’s worth 

remembering. 

If the Z-Score is beyond a value of two (positive or negative) then you must think of a large pool of 

observations against which to compare the value. For example, if the Z-Score is 6, then you must think in 

terms of millions of observations. Shaquille O’Neil is about 7’2” tall, so he is about 6 standard deviations 

above average. 7’2” translated into a Z score is about 6. You need probably about 100 million people 

(rather than 100) to be able to put that kind of “usual” into context. 

  

Figure 10: Z-Score and Percentile on a Bell Curve. 
In the graphic the 72.57 percentile is equivalent 
to .6 Z-score. Source: Wikimedia. 

https://en.wikipedia.org/wiki/Normalization_(statistics)
https://en.wikipedia.org/wiki/Outlier
https://en.wikipedia.org/wiki/Standard_score
https://commons.wikimedia.org/wiki/File:Z_score_for_Student_B.png
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Exercise 3A 

Describing Your Community with Descriptive Statistics. 
The first thing that many community organizations need to do is to truly understand their community. 

You can do that, of course, qualitatively, or holistically - but often if you want to secure a grant, or even 

describe to local stakeholders what makes your community different (or the same) you will probably be 

asked to produce some statistics about your community or neighborhood. Furthermore, if you expect to 

demonstrate programmatic success by your organization, you will also have to create statistics to show 

improvement in a before and after scenario.  The videos below help you learn some of the procedures 

necessary to describe communities. 

Student Learning Objectives 

• Students successfully describe a community using basic descriptive statistics (mean, median, 

standard deviation, etc.) 

• Students perform basic addition/subtraction using the formula tool in Excel. 

• Students prepare data for more advanced analysis or visualization. 

Program Objectives 

• Help communities identify their core needs. 

• Research complex issues and recommend evidence-based solutions. 

Background 

In this set of videos, we will use an income and tax measure (tax 

returns by ZIP code) to demonstrate how to describe a community. 

You should mark the data source. The California Open Data website 

has a lot of different and interesting data collections. We’ll be using 

one that contains Personal Income Tax Statistics by ZIP Code.  

Income is perhaps the most useful data for social scientists. It often 

has greater explanatory power than any other variable, but as always, 

caution must be exercised because income and ethnicity are often 

entangled in ways that are hard to separate. In Los Angeles, there are 

several wealthier enclaves of African Americans, but Latinx people with wealth tend not to self-

segregate much. There is no vast poor white neighborhood – so it becomes difficult to separate income 

and race/ethnicity sometimes. 

RAW DATA SOURCE: https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-

6e0c6f49c9c1/view/9c3b44be-8a29-40f0-bd6e-df817f6c442b# 

Instructions: 

Filter Data 

1. Open the dataset in Microsoft Excel. (Link to exercise data at geographyplanet.org) or download 

it from your learning management software.  Examine the data. 

2. Note there are many years of data and that each ZIP code has multiple years of data. 

3. Variables include the number of returns, Total Tax Liability, and various other geographic data. 

4. Note that in the green columns, the variables “Income per Return” and “Tax Per Return” and 

“Tax Percent” are normalized measures of income and taxation. 

Figure 11: YouTube Tutorial - Basic 
Descriptive Statistics with Excel (Tax Data), 
Part 1. URL: https://youtu.be/-dPEoUPGQDs  

https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code
https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-6e0c6f49c9c1/view/9c3b44be-8a29-40f0-bd6e-df817f6c442b
https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-6e0c6f49c9c1/view/9c3b44be-8a29-40f0-bd6e-df817f6c442b
https://geographyplanet.org/ca_taxes_by_zip_1992_2017/
https://www.youtube.com/embed/-dPEoUPGQDs?feature=oembed
https://youtu.be/-dPEoUPGQDs
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• The data is “normalized”, which means it was converted into percentages and/or rates 

to account for the fact that each ZIP code has a different population. Without the 

conversion, direct comparisons of income and taxation between ZIP codes are difficult 

because each ZIP code has a different population! 

5. From the Home tool ribbon, click on the Sort and Filter button and chose “Filter” from the list of 

options. Small down arrows will appear in each column header. 

6. From the County column, deselect “All” and select only “Los Angeles” – county. 

7. Repeat the process, for the YEAR column, so you are just using 2017 (2015 for your homework) 

8. Use the number filter tool on the RETURNS column. Select from the pop-up menu, “Number 

Filters” and from the options select “Greater than or Equal to” – and then use 1000 as your 

cutoff.  

• This will prevent ZIP codes with very small populations from being used in the analysis. 

ZIP codes (or census tracts, etc.) with a very small number of observations (families, 

people) tend to become troublesome outliers in your dataset and it is common practice 

to select a round number for an elimination criterion and discard such observations. 

9. Copy the data from columns A to K, paste it as values in a new sheet or workbook.  

10. You should have 272 rows.  You can adjust column width. 

Calculate Basic Statistics (Formula Method) 

11. Place your cursor in column D, one row below the bottom of the data block you just pasted. It 

should be below the column of City names. 

• It is good practice to never enter calculations in cells immediately adjacent (touching) 

the data cells or data block. If they are separate, then you may sort your data block and 

not accidentally entangle your calculations amidst the observations or data itself. 

12. In the cells below the city names (make sure to leave a blank ROW of data) enter the following 

words in successive cells and under the column of data containing numbers (RETURNS column – 

F) type in the following formulas: 

• Count   =COUNT(F2:F272) – you should get 271! 

• Mean   =AVERAGE(F2:F272) 

• Median   =MEDIAN(F2:F272) 

• Skewness  =SKEW(F2:F272) 

• Standard Deviation =STDEV.S(F2:F272) 

• Sum    =SUM(F2:F272) 

 

Press the F2 or double click in the cells containing formulas to activate the editing tool in case you make 

a mistake or want to view the formulas and graphics displaying included data. 

13. You may want to place your cursor in A2 and then click on the View Tab and select from the 

options “Split” (or Freeze Panes) to allow you to scroll to the bottom of the screen and still be 

able to see the top row containing column headers.  

14. Highlight and copy the formulas you just entered beneath column F and paste those in the 

adjacent cells to the right so that the formulas now calculate, mean, sum, count, etc. for the rest 

of the columns of data. Check your work.   Click Save. 

https://en.wikipedia.org/wiki/Outlier
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Calculate Basic Statistics (Data Analysis Tool) 

15. Next, click on the Data Tab. At the far right of the tool bar, there should be a button for Data 

Analysis tools. If it does exist find the instructions detailing Appendix 1: How to Install the Data 

Analysis ToolPak in Microsoft Excel near the end of this manual (or consult the video tutorial). 

16. Click on the Data Analysis tool button and from the pop-up dialog window, select “Descriptive 

Statistics” and click OK. 

17. Highlight the data block you want to analyze (F1 to K272) – that’s your input range. 

18. Make sure you check “Labels in First Row”. 

19. Check “Summary Statistics” and “New Worksheet Ply” – then click OK. 

20. Examine the statistics produced in your new worksheet ply. You may need to adjust the column 

widths to make everything easier to read. (end of video part 1). 

Part II: Visualizing Descriptive Statistics with Excel using Tax Data.  
Now we are going to create some visualizations (charts, graphs, etc.) of 

the data, because most people are visual learners, and it is far easier to 

quickly interpret the meaning of data with visual aids. 

Create A Histogram  

21. Click on Sheet 1 to activate that sheet (it’s the working copy of 

your data) 

22. Highlight the Returns column of data (F) and make sure you 

include the header (cell F1) 

23. Click on the Insert tab and from the tool ribbon click on the 

Histogram icon. (it looks like stair steps) You click on the down 

arrow next to the icons to get prompts. Or click on 

“Recommended Charts” and select the histogram from the list of suggestions. 

24. Automatically the software produces a histogram that shows the number of returns grouped 

evenly into ‘bins or ranges of observations.  

25. Note that the height of each ‘bar’ on the histogram indicates the number (count) of ZIP codes 

falling within each range. The range is indicated along the bottom horizontal or X-axis and the 

number of returns is on the Y or vertical axis.  

26. You may want to double click on the Chart Title and replace the generic title with one of your 

own, like “Number of Tax Returns: Los Angeles County – 2015” (or whatever is appropriate). 

27. Move your mouse over the graphic and note that specific values appear as you mouse over the 

bars on the histogram.  

28. Note that you can right-click on your graphic, select “Copy” from the popup window and then 

paste the graphic in another software (Word, PowerPoint, etc.) 

29. Note that the histogram boxes are more common on the right side of the tallest bar, which is 

near the average. Though there are more ‘bins’ on the right, the pattern is generally 

symmetrical which visually suggests that the data is slightly skewed to the right (positive skew) 

and the value you calculated earlier confirms that (the video has some discussion of this point). 

30. Next, click on the Histogram graphic to activate it. Note that the data being visualized is 

indicated by a blue line encompassing all the data and a red line encompassing the data header. 

31. Click on the edge of the “blue box” surrounding the data and drag it one column over, so that 

you have a histogram of “CA_AdjGrsInc” or California Adjusted Gross Income in column G.  

Figure 12: YouTube Tutorial: Descriptive 
Statistics with Excel Using Tax Data (part 2) 
URL: https://youtu.be/S5GPdrzr8xo  

https://www.youtube.com/embed/S5GPdrzr8xo?feature=oembed
https://youtu.be/S5GPdrzr8xo
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32.  Note the changes in the histogram. The adjusted gross income is much more skewed. Note that 

one ZIP code in Los Angeles has a total adjusted gross income of close to $7.5 billion. 

33. Note the skewness value (2.66) for this variable. 

34. Note that the mean is moved further away (in relative terms) from the median than it was for 

returns. 

35. Change once again the variable appearing in the histogram. Use “IncPerRtrn” or Income Per 

Return to make yet another histogram. Note the skewness value you calculated (it’s over 3 – 

which is often seen as “badly skewed”) and how that skewness appears in the graphic. 

36. Finally, create a histogram of “TaxPct” or “Percent Income Taxed” and note the value of 

skewness, the shape of the histogram, and the relative difference between mean and median. 

------------------------------ 

For credit consult your learning management software.  

You will likely be required to replicate the steps above (or in the video) to produce a file. Students are 

likely to be asked to use the 2015 data rather than the 2017 data shown in the video. You are likely to be 

asked to upload an Excel file (or a Word file with a screenshot of evidence of your mastery of the 

procedures evident in the video) to your learning management system. 

Your instructor will likely check to see if you manually calculated (with formulas) these descriptive 

statistics and if you were able to use the Data Analysis ToolPak and able to create a histogram of at least 

one dataset.  
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Exercise 3-B: Calculating Percentiles and Z-Scores 
Background 
Now that you have learned to calculate several basic descriptive statistics about your community and 

perhaps about the larger society itself, it is time to learn how to put individual observations 

(neighborhoods, ZIP codes, census tracts) into the context created by a larger community (nation, state, 

county, city, etc.)   

All communities are different. That’s an undeniable fact of the world. However, some communities are 

only moderately different from ‘average’ – and some are very different. The point of this exercise is to 

compare data from different communities so that you may answer the question: “How different is my 

community from the average?” 

In statistics, big differences are labeled, “significant” and that means, most of the time, that you can be 

at least 95% confident that you would not be making a mistake if you claimed, “they are different”. Put 

another way, you are 95% confident that the difference is unlikely to be due to random variation in the 

data. Generally, the 95% confidence level is aligned with roughly two (1.96) standard deviations 

difference from some expected level – which is generally the statistical mean or average. 

Student Learning Objectives 

• Students successfully describe a community using descriptive statistics (rank percentiles and z-

scores 

• Students prepare data for more advanced analysis or visualization. 

Program Objectives 

• Research complex issues and recommend evidence-based solutions. 

• Help communities identify their core needs. 

Instructions: 
Your task is to follow along with the tutorial videos embedded below 

and replicate the procedures. 

Excel File used in the tutorial video (also available in your learning 

management software) 

Excel File: California Free and Reduced School Meal Program Data 

2018-19 (.xlsx) | Geography Planet 

Steps: 

1. Open the appropriate file in Microsoft Excel.  Note there are 

multiple worksheets of data. 

2. Examine the data in the FRPM School-Level Data sheet. Note that it includes data on the 

number and percentages of students in each school in the state eligible for free or reduced 

lunch for 2018-2019. 

3. Click on the down arrow in cell E2 “County Name”, the column header for column E and deselect 

“Select all” and select only “Los Angeles”. Note only schools in Los Angeles remain visible. 

Figure 13: Video Tutorial: Calculating 
Percentiles and Z-Scores in Excel Using 
School Enrollment Data.  
URL: https://youtu.be/eSmeKuSPbGY  

https://geographyplanet.org/learning-resources/tutorials-and-files/ca_free_reduced_school_meal_program_2018_19/
https://geographyplanet.org/learning-resources/tutorials-and-files/ca_free_reduced_school_meal_program_2018_19/
https://www.youtube.com/embed/eSmeKuSPbGY?feature=oembed
https://youtu.be/eSmeKuSPbGY
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4. Repeat the process for column I, “School Type”. Filter the data so only “Elementary Schools 

(Public)” 

5.  Repeat the process for column R, “Enrollment (K-12)”. When the dialog box appears, use the 

“Number Filters” option to select only those schools with an enrollment “Greater Than or Equal 

to:” – enter 100 in the “Custom AutoFilter” topmost box. Then click OK. 

a. Note this filter removes very small schools that would likely introduce data outliers into 

our sample. 

6. Select and copy all the data from column G through T…from ROW 2 all the way to the bottom of 

the data.   

7. Press Ctrl + N to open a new workbook and paste the data block you have copied into cell A1 of 

the new workbook.  You should have 1284 rows of data including the column header. 

8. Highlight columns B through K and click on the delete button in the Home tab to remove those 

columns of data. 

9. You may also delete the column containing “Free Meal Count”. 

a. This should leave you with only three columns:  

• School Name 

• Enrollment (K-12)  

• “Percent (%) Eligible Free (K-12) 

Find the Average/Mean Percent of Students at Schools Eligible for Free Lunch 

10. Position your cursor in a cell two rows beneath the last school’s name in column A (cell A1286?) 

11. Type in Average and below that type Standard Deviation. 

12. In cell B1286, type =AVERAGE(B2:B1284) to get the mean number of students enrolled in the 

data sample.  

13. Copy that formula and paste it in cell C1286 to get the average percentage of students eligible 

for free school lunch in elementary schools (over 100 enrolled) in Los Angeles County. 

14. Repeat the process but move your cursor to cell B1287 and type =stdev.s(B2:B1284). 

15. Copy the standard deviation formula to the cell to the right (C1287) to get the standard 

deviation for the values in column C. ** or use stdev.p** 

Calculate Rank Percentile for Each School – for enrollment and Percent 

eligible for Free Lunch. 

16. In cell D1 type “PercentileEnr” – (percentile enrollment) 

17. In cell D2 type =PERCENTRANK.INC($B$2:$B$1284,B2,4) 

18. Copy that formula to the rest of the rows in column D (cells 

D3 to D1284) 

19. Sort the data by column B – make sure you are not including 

row 1 in the sort. Note that the largest school by enrollment 

should be at the 1 (100th) percentile, and the smallest school 

should be at the zero (0) percentile. 

20. In cell E1 type “PercentileFL” 

21. In cell E2 type =PERCENTILERANK.INC($C$2:$C$1284,C2,4). 

Press Enter 

22. Copy that formula to the rest of the rows in column E (cells E3 to E1284) 

Figure 14: Video Tutorial: Calculating Z 
Scores in Excel Using School Enrollment 
and Lunch Data, Part 2. URL: 
https://youtu.be/kZW61RXlo0o  

https://www.youtube.com/embed/kZW61RXlo0o?feature=oembed
https://youtu.be/kZW61RXlo0o
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23. Sort the data by column C (Percent eligible) to check your work. Note that a handful of schools 

have 100% of their students eligible for free lunch. They are all tied in terms of percentile at 

99.21 percentile. 

Standardize the Values for Enrollment and Percent Eligible – by Creating Z-Scores. 

24. In cell F1 type “StndErol” 

25. In cell F2 enter the following formula: =standardize(B2,$B$1286,$B$1287) 

a. B2 refers to the enrollment figure in cell B2 

b. $B$1286 is a frozen reference to the value you calculated for average enrollment. 

c. $B$1287 is a frozen reference to the value you calculated for standard deviation. 

26. Copy that formula to the rest of the rows in column F. 

a. Now you have a column of Z-scores. 

27. Type “StandFL” for “Standardized Free Lunch” in cell G1 

28. Repeat the process, but now calculate the Z score for the values in column C in column F. 

o Note that you have two new columns of Z scores which tells you how many standard 

deviations each school is away from the average(mean) on each metric. 

29. Sort the data once again by the values in Column B (Enrollment) 

30. Find the schools that have z-score below -1.96 and above 1.96 for both new columns of data. 

31. Sort the data by the values in column C (percent eligible)  

32. Find the schools that have z-score below -1.96 and above 1.96 for both new columns of data. 

Create a Histogram of the data in Columns B and C 

33. Highlight the data values in column B. 

34. Click on the Insert tab 

35. On the Insert toolbar, click on the Histogram icon. 

36. From the pop-up window select the standard histogram (upper right). 

37. Examine the histogram, noting the left skew (negative skew) in the data. 

_________________________ 

For Credit: Consult with your instructor or learning management system.  

You are likely to be required to submit evidence of your ability to calculate percentiles and Z-scores 

(standardize) the data presented – as well as creating a quick histogram of the data. 

You are also likely to be asked to submit evidence in which you write a short explanation of the value of 

the calculations you just created and a paragraph explaining how to interpret the values you generated. 

 

Raw Data Source: https://www.cde.ca.gov/ds/sd/sd/files 

  

https://www.cde.ca.gov/ds/sd/sd/files


 
 

29 
 

Chapter 4: Inferential Statistics 
Inferential Statistics are measurements that build upon the descriptive statistics we have been learning 

about. The main difference is that inferential statistics allow us to answer questions about differences 

between and among datasets using a hypothesis. In statistics, a hypothesis is a statement, generally 

constructed using an “if-then” statement that allows us to either support (or reject) a statement of fact 

about some statistical condition evident in our data. Most of the time, in statistics, this “statement” is 

set up as a null hypothesis, which can be translated into plain English as “there’s no major difference 

between these two sets of data” or “nothing unusual is going on here”. Working back to the examples 

from earlier, if we wanted to make a statement that NBA players are unusually tall, we might create a 

hypothesis that stated, “If the NBA players are of normal height, then their mean height will be not 

much greater than the average height of American men (5’9”)”. We would use an inferential statistic to 

test it. An analysis of the average height of American men and those playing professional basketball 

hypothesis would no doubt require us to “reject the null hypothesis” because we would surely find using 

an inferential statistic that there is a statistically significant difference between the average height of 

American men (population mean or µ) and the average height of NBA players (sample mean or �̅� ). We 

could be 95% sure (or more) of it (significance = 0.05). 

Statistical Significance 
In much of what we are doing in this course, we would start with a question such as “Is this community 

really that poor (polluted, violent, underfunded, etc.)? Rather than just relying on our instincts or using 

an ‘eyeball test’, a proper answer requires a little more work. Generally, that involves the construction 

of a hypothesis that has a threshold of certainty. In stats lingo that’s level of certainty is called a 

confidence interval and confidence is accompanied by a level of significance. We must establish how 

confident we need to be, and then find a test capable of measuring our certainty about the answer.  

Most of the time, social scientists use a threshold of confidence of 95%. This means we want to have 

less than a 5% chance of being wrong if we claim something like “This neighborhood is really poor”. So, 

the statistical significance of most tests is set at 0.05. Sometimes the threshold is lower, and you only 

require 90% certainty – in which case the significance is set at 0.10. Sometimes the threshold is 99%, so 

the significance level is 0.01. 

Although it is not technically correct to state it this way, a common way of explaining the concept of 

statistical significance is to say that “you’re 95% sure that what we’re seeing is not due to random 

chance”.  

T-Test 
The t-test is the most common family of tests used to determine whether a value is really and truly 

different or unusual. It leverages the same concepts as the Z-score or standardized score we learned 

earlier, along with the mean (average) and standard deviation to compare two groups of observations 

(or two data sets). 

For example, you might have income data for the entire county at the census tract level and you want to 

compare that to a data set that is similar but includes just the census tracts on “the South Side of town”. 

Maybe you want to determine if neighborhoods on the South Side are truly richer (or poorer) than the 

entire county. Or perhaps, you have data on crime rates for many cities in 2019 and you want to find out 

if the rates were significantly lower (or higher) in the pandemic year of 2020.  

https://en.wikipedia.org/wiki/Statistical_inference
https://en.wikipedia.org/wiki/Statistical_hypothesis_testing
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In both cases, you would use a t-test to determine the magnitude of difference and a threshold of 

confidence in which you can safely state a case about differences.  

T-tests allow you to measure the magnitude of difference between two datasets. In the figure above, on 

the left, we see that the mean of the red (left) curve describing the sample data is significantly different 

than the mean of the blue curve (right) describing the population data, therefore we would expect the 

test statistic to be large, with a small p-value (< 0.05) indicating at least 95% confidence that difference 

exists. Crossing that confidence interval indicates a significant difference between the two groups. The 

p-value is a measure of the likelihood you would be making a mistake based on your findings. In the 

figure above on the left, a small p-value of say, 0.03 would allow you to be 97% confident that the 

means are different. Generally, we only need to be 95% (p = 0.05) confident to reject the null and say 

instead, “those are different” or “that one is definitely bigger”. 

The curves in Figure 15 (left) indicate a moderate difference in the mean of the red (sample) and blue 

(population) means, so we would expect to see a smaller test statistic (t value) and a larger p-value. 

Here we might find a p-value of 0.25, which would only allow us to be about 75% confident that there is 

a difference between those means. That’s not good enough, so we would likely accept the null 

hypothesis (no significant difference). 

Most of the time the test statistic we use to compare data on two data samples would be a one-tailed 

test, because we are seeking to determine if the mean value for income, pollution, crime, etc. of one 

group is significantly bigger (or smaller) than the mean of the comparison group. Sometimes, you’ll just 

check only to see if the two means are simply different – that’s a two-tailed test. It is easier to get a 

significant result (p < 0.05) using a one-tailed test, but you should know that you are in essence 

declaring it impossible to find the opposite outcome by selecting a one-tailed test. 

There are a variety of these tests, but the main t-tests include: 

• One sample difference of means t-test – to see if a sample is different than a population. 

o E.g., one city (sample) vs. the whole state (population) 

• Two sample difference of means t-test – to see if two samples are different.  

o E.g., city A vs. city B. 

• Matched Pair t-test – to see if a change between time 1 (before) and time 2 is significant. 

o E.g., Community A crime rate before program vs. Community A crime rate after a 

programmatic intervention. 

 

Small di erence between sample and popula on means

 Accept the null hypothesis

 Large p value (  0.05)

Figure 15: Curves Showing Different difference between Sample and Population Distributions measured by a t-test. Source: 
Author 

https://en.wikipedia.org/wiki/P-value
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The matched pair test would be very useful for measuring success in programs designed to improve 

community conditions. 

If you have more than three samples you need to compare to see if they are drawn from the same 

underlying population, you need to use the analysis of variance or ANOVA test. This test uses similar 

logic as the t-tests discussed above, it is widely used, and widely available in statistical software, 

including Microsoft Excel. 

  

https://en.wikipedia.org/wiki/Analysis_of_variance
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Exercise 4-A:  

T-Tests: Comparing Age and Ethnicity in Arrest Data Using LAPD Data 
One of the most important things you can demonstrate as a community activist or social scientist is 

difference, and that often requires a statistical test of difference.  The most common statistical test for 

difference is the difference of means t-test, which allows you to measure just how big of a difference 

exists between a specific community and the population at large, or the same community over time. 

In this exercise, you will conduct several t-tests to compare the average age of arrested persons from 

several groups. In one test, you will compare the average age of persons from one ethnicity (sample 1) 

who were arrested for aggravated assault against the average age of persons arrested for the same 

crime from another ethnicity (sample 2). Then you will compare the age of arrestees from one ethnicity 

(sample 1) against the overall average age (population). The test results will indicate if the age of 

arrested persons is significantly different from one ethnicity to another – or from all arrestees. 

Finally, you’ll compare the number of DUI arrests between years using the Paired Samples t-test. Note 

that the data we use (counts) are inappropriate for this test but will suffice for demonstration purposes. 

Student Learning Objectives 

• Students successfully use an inferential statistic (t-test) to test a hypothesis about differences in 

a sample (neighborhood community) and an overall population. 

• Students successfully use an inferential statistic (matched pair t-test) to test a hypothesis about 

differences in a sample (neighborhood community) at one time and a second time interval. 

Objectives 

• Help communities identify their core needs. 

• Research complex issues and recommend evidence-based solutions. 

Instructions:  

1. Open the data in Microsoft Excel (or consult your instructor) 

Excel File: LAPD Arrest Data 2015-2020 (xlsx) Click to 

Download – LARGE FILE. | Geography Planet 

2. Examine the columns of data and column headers. 

3. Click on the Insert tab and select Pivot table from the top 

toolbar.  Click OK.  A new sheet will appear. 

4. In the Pivot Table fields box, click-and-drag “Descent Code” 

from the variable list into the “Rows” box. 

5. Next click-and-drag “Area Name” from the variable list into 

the “Rows” box …make sure it is below “Descent Code”. Note 

the effect in the pivot table itself.  

6. Click-and-drag “Descent Code” once again from the variable fields and place it in the “Values” 

box to get a count of persons arrested by “descent” (ethnicity) in the various LAPD divisions (I’m 

going to call them precincts) across Los Angeles. 

7. Click-and-drag “Age” from the variable fields and place it in the “Values” box.  

8. Click on “Sum of Age” in the “Values” box to bring up a menu of options.  

Figure 16: Video Tutorial - Calculating 
t-tests with LAPD Data. URL: 
https://youtu.be/lQia7qOyMK8  

https://geographyplanet.org/learning-resources/tutorials-and-files/lapd_arrest_data_2015_2020/
https://geographyplanet.org/learning-resources/tutorials-and-files/lapd_arrest_data_2015_2020/
https://www.youtube.com/embed/lQia7qOyMK8?feature=oembed
https://youtu.be/lQia7qOyMK8
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9. Select “Value Field Settings” and from the pop-up window change the setting from Sum 

(default) to “Average” to get the average age of arrested persons by ethnicity and precinct. Click 

Ok. 

Narrow Your Sample with Filters 

10. Click-and-drag “Charge Group Description” from the variable names into the “Filters” box. 

11. Click on the down arrow in cell A1 (“Charge Group Description (All)) and from the menu that 

appears, click on “Select Multiple Items”, then deselect “Select All” and click “Aggravated 

Assault” to narrow down the crime type.  Click OK. 

12. Click on the down arrow in cell A3 (“Row Labels”) and from the pop-up window, deselect “Select 

All” and instead check to select just the following ethnicities:  B (Black) H (Hispanic) O (Other) W 

(White). Click OK. 

13. Note that by using those filters, nearly every precinct has at least 30 observations (persons) 

arrested from each ethnicity group (descent code). 30 is a good minimum number of 

observations to strive for in many statistical operations. 

14. You may remove “Count of Descent Code” from the “Value Box” leaving just “Average Age.” 

15. Click-and-drag “Descent Code” from the “Rows” box to the “Columns” box in the Pivot Table 

fields window. That will create in the pivot tables column headers with the four ethnicities and 

the rows will have precinct names. The pivot table data includes just the average age of persons 

arrested for assault by precinct and by selected ethnicity. Cool.  

Move the data from the Pivot Table to a new worksheet ply. 

16. Highlight the data and single column header in the pivot table and copy it. 

17. Click on the plus sign at the bottom of the Excel window to create a new worksheet. 

18. Place your cursor in cell A1 and paste the values from the pivot table. You should have a column 

of precincts and four columns of data (B, H, O, W), and perhaps the “Grand Total” column. 

*the video has an unnecessary step in which you copy and paste the Grand Total in a separate 

step. 

Activate the Data Analysis Toolbox to Calculate a Two-Sample t-Test. 

19. Click on the Data tab and locate the Data Analysis button on the far right of the Data Toolbar. 

20. If the Data Analysis tools have not been activated follow the steps in Appendix 1 of this text/lab 

manual. 

21. From the Data Analysis tools, select “t-Test: Two-Sample Assuming Unequal Variances” and click 

OK. 

22. In the dialog box that pops up, put your cursor in the box next to “Variable 1 Range:” and then 

highlight (click and drag) over the column header and data representing the average age of 

Blacks by precinct.  Do not include the Grand Total figure. 

23. For the Variable 2 Range click in that box, then highlight the column of data for Hispanics 

(including the column header, but not the Grand Total row). 

24. Click in the box next to “Labels”.  

25. Leave the “Alpha” setting at 0.05 (95% confidence level) 

26. Click OK. Note a new worksheet ply will appear with the test diagnostics output. Examine the 

output diagnostics. 
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27. Note that Black arrestees are on average 35.263 years old and Hispanic arrestees are 31.495. 

The t-test will tell us if this is a significant difference in average age. 

28. Note that the t-statistic value is 7.15 (that’s big!) 

29. Note that the “critical value” for a one-tailed test (are Blacks older than Hispanics) at the 95% 

confidence level equals 1.70. For the two-tailed test, the critical value is 2.05.  

30. Note that 7.15 is larger than both 1.70 and 2.05, so we can safely assume that the average age 

of Blacks in this dataset is significantly older (1-tail) and significantly different (2-tailed) than 

Hispanics. 

31. Note that the p-value (confidence) for both tests is so small that Excel converts it to scientific 

notation. You will see something like 5.410E-08.  

• If you want to change the appearance of your p-value, click on the Home tab, and click 

in the cell you want to change, and then from the Number style options change it from 

“General” to “Number”. You may also wish to expand the number of visible decimal 

places in the cell by clicking on the “Increase decimal” button. No more than three 

decimal places are usually necessary, but it’s interesting to see sometimes how “certain” 

the test results are. In this case: 0.0000000541 

• This value represents the chance you would be wrong if you said, “The mean for Black is 

larger than the mean value for Hispanics”. It’s minuscule.  

• You could “reject the null” hypothesis states that there is no difference in the mean age 

of these two groups. 

32. Repeat the calculation, but substitute “White” and “Other” for Hispanic and examine your 

results. 

33. Note that White persons are older than Black persons and the same holds true for “Other”, 

although the two-tailed difference is close to the critical value between “Black and Other”. 

Compare the Population Mean against Sample Means. 

34. Click on the Data tab and click on the “Data Analysis” button 

to activate the data analysis tools. 

35. To calculate a t-value comparing the overall population mean 

with the sample population follow the steps below. Basically, 

you are repeating the steps from above but using the values 

from the Grand Total column or “All Ethnicities” column as 

the comparison data. 

36. Compare the value for Blacks against All (Grand Total) 

37. Note that the value for Black is greater than for ALL, but the t-

value (1.87) exceeds the critical value ONLY for the one-tail test (1.69), but not for the two-tailed 

test (2.03). Your confidence level for the one-tail test is about 96.5 (p=0.035) but is only 93% 

(p=0.07) for the two-tailed test.  

*Note that the same test can be calculated using the formula =T.TEST(array1,array2,x,y) in Excel. You 

can enter the data array (data value for “All”) and freeze the cell references with the F4 key, enter the 

data for the second data array (data values for “Black”) enter x=1,y=3, in the rest of the formula to 

indicate a one-tailed version of the two-sample test assuming unequal variances, then copy the formula 

horizontally across the series of cells to compare the “All” group to the rest of the data for each 

ethnicity. The output value is a p-value. 

Figure 17: Calculating t-Tests with 
LAPD Data. URL: 
https://youtu.be/GGXFoNTm74g  

https://www.youtube.com/embed/GGXFoNTm74g?feature=oembed
https://youtu.be/GGXFoNTm74g
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Compare Mean Values from One Year Against Another – Paired Two-Sample for Means t-Test. 

* note that the values used in this last segment are NOT averages (means) so the difference of means t-test to 

compare this data is not a strictly valid application of this statistic …but it will stand for illustrative purposes. If I had 

provided “Average Age” rather than arrest counts, it would be legitimate, but few of the results would be 

significant (or interesting) 

38. Return to the main datasheet and click on Insert and then Pivot Table to create a new pivot 

table of the data. 

39. In the Pivot Table fields window, click-and-drag “Area Name” from the list of the variable names 

and place it in the “Rows” box. 

40. Click-and-drag “Arrest Date” from the list of the variable names and place it below “Area” name 

in the “Rows” box. 

• Note that Excel will parse your date data automatically into “Years” “Quarters” and 

“Arrest Date”. 

41. Click-and-drag “Years” from the “Rows” box into the “Columns” box to get a column of years in 

the pivot table. 

42. Click-and-drag “Arrest Date” and “Quarters” back into the variable names box to delete those 

variables from your pivot table. 

43. Click-and-drag “Charge Group Description” into the “Values” box to get a count of all crimes by 

year and by precinct.  

44. Click-and-drag “Charge Group Description” to the “Filters” box. 

45. Note that the Filter option for Charge Group Description is now in Cell A1. 

46. Click on the down arrow in Cell A1 to open the dialog box. 

47. Click on “Select Multiple Items”  

48. Click on the box next to “All” to DESELECT all and then click “Driving Under Influence” from the 

list of charge code descriptions to get only DUI arrests per precinct per year. 

49. Click in the pivot table to activate it. 

50. Click on the Insert tab at the top. 

51. Click on the line graph button from the list of chart options. 

52. Select 2D as the type of line graph.  

53. Examine the line graph created. You may want to click on the Years down arrow in the graphic 

and deselect all but 2015 and 2019 to declutter the graph and see two of the more distinct 

patterns. 

54. Copy and paste the data from the pivot table to a new sheet or to someplace below the pivot 

table. 

Run the Paired Sample t-test.  

*note this test is using “count” rather than mean (so it’s a violation of the requirements of the test, so it 

stands as a demonstration of the concept rather than a legitimate use of the statistic) a better example 

would have used the mean age of arrested persons per year, or average DUI arrests per day, e.g. 

55. Click on the Data tab and select from the far right the Data Analysis button. 

56. From the data analysis tools, select “t-test: Paired Two-Sample for Means” and click OK. 

57. Highlight the data and column header for 2015 for Range 1. Do not include Grand Total values. 

58. Highlight the data and column header for 2019 for Range 2. Do not include Grand Total values. 
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59. Make sure “Labels” is checked. 

60. Leave the Hypothesized Mean Difference at zero and the “Alpha” value at 0.05. 

61. Place the output in a new worksheet ply or select a cell value to the right of your data block. 

62. Click OK and examine the output diagnostics for this t-test. 

63. Note that for DUI arrests, the sample for 2019 is significantly lower than in 2015 indicating a 

substantial change/drop in arrests between those years (t = over the critical value of 1.72 for the 

one-tailed test and 2.086 for the two-tailed test…the p-values are all well below 0.05). 

64. Repeat the test but compare 2017 and 2018. You’ll note that the t-test indicates a less-than-

significant reduction in the number of DUI violations between those years. 

 

_________________________ 

For Credit: Consult with your instructor. Your instructor will likely ask you to submit evidence of your 

competency in conducting several types of difference of means t-tests using the supplied data. 

You are also likely to be asked to submit this evidence alongside a half-page of text in which you provide 

evidence that you understand why t-test are useful devices to compare community characteristics, or 

programmatic outcomes (change).  You will also be asked to demonstrate that you know how to 

interpret the statistical output generated by the software. You should be able to explain the meaning of 

the t value and p-value. 

Data Source: Los Angeles City Data Portal: 

https://data.lacity.org/Public-Safety/Arrest-Data-from-2010-to-2019/yru6-6re4 (Links to an external 

site.) 

 

  

https://data.lacity.org/Public-Safety/Arrest-Data-from-2010-to-2019/yru6-6re4%20(Links%20to%20an%20external%20site.)
https://data.lacity.org/Public-Safety/Arrest-Data-from-2010-to-2019/yru6-6re4%20(Links%20to%20an%20external%20site.)
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Chapter 5: Analytical Statistics: Correlation and Regression 
For most people on the front lines of social change, it is not just enough to describe conditions within a 

community of need. Community activists striving to improve their community often require some 

understanding of the root causes of problems affecting communities. This chapter offers some brief 

insight into the utility of statistical measures of association, i.e., correlation and regression, for leaders 

who want to better understand relationships between various aspects of their community. 

Correlation 
The most common, and perhaps most transparent of the 

measures of association between two variables is the 

correlation coefficient. Using correlation tests provides 

information about both the strength and the direction of 

association between two datasets. For example, you might be 

interested in the association between obesity and income. 

You might want to know if poor kids are more likely to be 

obese than rich kids. The correlation coefficient, expressed as 

a number between -1 and 1, indicates a positive association if 

the value is between 0 and +1, and an inverse (or negative) 

association when the number is between 0 and -1. The 

strength of the association (or relationship) is indicated by the 

size of the coefficient. The further from 0 the stronger the association. The most common correlation 

measure is Pearson’s Correlation Coefficient uses the lower-case italicized letter “r” to indicate the 

direction and strength of association.  

In Figure 18, you can see in the upper row, scatterplot diagrams with positive correlations of r = 0.7 

(upper left); r = 0.3 (upper middle), and r = 0.0 (upper right). You can interpret the r (coefficient) value of 

0.7 as “seventy percent of the increase in one variable is matched by an equal amount of increase in the 

other”. The same figure illustrates inverse or negative correlations on the bottom row. In negative 

correlations, an increase in one variable is matched by a decrease in the other. The strength of the 

association between the two variables is highest in cells on the left, modest in the middle column of 

illustrations, and weak or non-existent on the right.  

Comparing two variables for a correlation is a useful first step as you seek to understand why the world 

works the way it does, but it is important to be cautious with the results of correlation tests. First, it is 

extremely important to understand that correlation tests do not indicate cause-and-effect. The famous 

adage “correlation does not imply causation” remains true. Several factors must be kept in mind. First, 

correlation does not indicate a direction of the association. For example, the sale of ice cream and 

bathing suits may have a strong positive correlation, but there is no way to tell if bathing suits are 

causing ice cream sales to increase or vice-verse. Second, it could be that the two variables have a 

strong association, but no actual relationship. This condition is called a spurious relationship. There is an 

entire web page dedicated to strong and absurd correlations between unrelated variables. Finally, there 

is often a third lurking or confounding variable that may be creating a correlation between two 

variables. That’s probably the case with the example of ice cream and bikinis above. 

Figure 18: Scatterplot diagrams with Pearson 
Correlation Coefficients. Source: Wikimedia, URL: 
https://commons.wikimedia.org/wiki/File:Pearson_Cor
relation_Coefficient_and_associated_scatterplots.png  

https://en.wikipedia.org/wiki/Correlation_and_dependence
https://en.wikipedia.org/wiki/Correlation_coefficient
https://en.wikipedia.org/wiki/Pearson_correlation_coefficient
https://en.wikipedia.org/wiki/Correlation_does_not_imply_causation#:~:text=The%20phrase%20%22correlation%20does%20not,association%20or%20correlation%20between%20them.
https://en.wikipedia.org/wiki/Spurious_relationship
https://www.tylervigen.com/spurious-correlations
https://en.wikipedia.org/wiki/Confounding
https://commons.wikimedia.org/wiki/File:Pearson_Correlation_Coefficient_and_associated_scatterplots.png
https://commons.wikimedia.org/wiki/File:Pearson_Correlation_Coefficient_and_associated_scatterplots.png
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There are statistical problems that confront you when you try to run a correlation test as well that you 

should be aware of. First, a strongly skewed distribution of observations in one or both variables can 

produce a correlation coefficient that is counterintuitive, or weaker than you might guess. When that 

happens, sometimes it is useful to convert the data to some other scale. Perhaps, normalizing the data 

by converting one or both data sets to a rate, percent, percentile would help. Ranking data is a common 

technique to reduce skewing in the data so it can be used. Calculating a correlation coefficient on ranked 

data even has its own test: Spearman’s Rho – or Spearman’s Rank Correlation. 

With caution, however, the results of a correlation test can be a quick and transparent way to indicate 

that a relationship between two conditions is likely and indicating a need for further study. 

Regression Modeling 
One of the more sophisticated and powerful statistical tools used by scientists is regression analysis, 

which is a type of predictive statistics also called data modeling. Regression is often the next logical step 

to take after completing a round of correlation tests. There are multiple varieties of regression models, 

but they all provide a way to understand the strength and direction of causal relationships between a 

dependent (outcome) variable and one or more independent (causal, explanatory, predictor) variables. 

Scientists and social scientists use regression to estimate relationships between variables of interest. 

Some use regression to make predictions (like weather forecasting) and others will use regression to 

argue for the presence of cause-and-effect relationships.  

Like correlation, it is possible to mistakenly assume or claim a causal relationship exists between 

variables, when in fact none do. So, it is very important that you can justify or explain why a causal 

relationship exists. Logic must be used in addition to mathematics. 

For this course, we’ll focus on linear regression, and its close cousin, ordinary least squares regression. 

They are common and well-understood data modeling techniques. These regression models may employ 

a single explanatory variable (simple linear regression) or multiple explanatory variables (multiple linear 

regression), though you should know that including too many (five?) explanatory variables sometimes 

degrade data models. 

It is not necessary to understand all the mathematics that powers the model fully, nor is it necessary to 

know how to manually complete the steps involved. However, it is important to understand a bit of 

what is going on when you ask the software to ‘run a model’ for you.  

First, identify the effect or outcome variable. It is the phenomenon you want to understand. Depending 

on the software or the statistical lingo, the “effect” variable may be called the dependent, “Y”, outcome, 

or response variable. Next, identify the likely variable(s) that you believe are on the cause side of the 

equation. They may be called independent, “X”, predictor, or explanatory variables. Some call them 

regressors.  

Perhaps the most difficult element of performing regression modeling in today’s computing 

environment is evaluating data to see if will work well in a model. Make sure you examine the dataset 

for variable skewness. Adjust when possible so that your data is as normal as possible. Occasionally, 

outliers must be removed. It is not uncommon to adjust badly skewed data by converting it to a 

logarithmic scale. Luckily, we have software to complete most conversions for us. Neither nominal nor 

https://en.wikipedia.org/wiki/Spearman%27s_rank_correlation_coefficient
https://en.wikipedia.org/wiki/Regression_analysis
https://en.wikipedia.org/wiki/Linear_regression
https://en.wikipedia.org/wiki/Ordinary_least_squares
https://en.wikipedia.org/wiki/Outlier
https://en.wikipedia.org/wiki/Logarithmic_scale
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ordinal (ranked data) can be used. The data should be drawn from a random sample, though there is 

debate about exactly how close to a 100% sample is warranted.  

Then you can begin experimenting with likely variables using 

software. The software will statistically evaluate the 

relationship between the dependent variable and 

independent variable(s). Be aware that some independent 

variables (e.g., ethnicity and educational attainment) may be 

highly correlated themselves, a condition called 

multicollinearity that may require you to remove one or more 

variables from the model. 

Regression models create a best-fit estimate (see red line on 

Figure 19) from the data presented. The process is like 

running correlation a bunch of times, calculating the average of all those correlations together at once 

to identify an overall relationship – which is represented by the best fit or trend line. How closely all the 

points (observations) cluster around the prediction indicated by the trend line describes graphically the 

model’s “fit”. When the data is closely clustered around the best fit line, prediction closely matches 

observation, and the R2 value moves closer to 1.0. Unlike correlation coefficients, R2 is always positive. It 

is possible to raise the R2 by adding additional explanatory variables to a model, but most models 

penalize adding too many independent variables, requiring users to refer to the most important 

outcome diagnostic called Adjusted R2 – a value that accounts for each additional explanatory variable. 

The distance between each data point or observation (“observed” points on the figure above) and the 

best-fit trend line (representing the estimated or predicted values) is called a residual. The larger the 

sum of the residuals, the worse the “fit” of the model and the lower the R2 value. Residuals also highlight 

outliers – observations (people, places, etc.) where the model does a poor job of prediction. 

Observations with unusually large residual values often highlight problems in a model or unusual or 

skewed observations. In a recent study conducted by your author, a model of crime rates in Seattle had 

an adjusted R2 value of nearly .80 (very good). One neighborhood stood out because it had a much 

lower crime rate than the model predicted. Since the model used predictors like household income, 

percent of residents between 15-25 years old, residential stability, etc. the model badly over predicted 

the crime rate in a neighborhood next to the University of Washington (where lots of impoverished, 

ever-moving, college-aged students lived). This neighborhood’s large difference from the prediction 

made it an outlier and invited the inclusion of another variable, perhaps “percent currently enrolled in 

college”. In studies of Los Angeles, the Skid Row region is a common outlier among residuals. Tables, 

maps, and graphs of residuals are useful to analyze because they invite speculation about the model and 

specific outliers. 

The overall strength or fit of a model is reported as the R2 and adjusted R2 values. Some software 

produces additional measures of model “fit” as well. The significance of the model is also important. 

Generally, it is represented by the F statistic. Once again, any value of greater than 1.96 allows you to be 

at least 95% confident that the value of R2 is statistically significant, one not likely to be due to random 

chance (in the common parlance). Low F values are more likely with poorly fit models or models with 

too few observations. 

Figure 19: Regression Plot. Source: Wikimedia. 
URL:https://commons.wikimedia.org/wiki/File:Residual
s_for_Linear_Regression_Fit.png 

https://en.wikipedia.org/wiki/Multicollinearity
https://commons.wikimedia.org/wiki/File:Residuals_for_Linear_Regression_Fit.png
https://commons.wikimedia.org/wiki/File:Residuals_for_Linear_Regression_Fit.png
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Generally, there is a second set of diagnostics produced by the software that explains the value or effect 

of each explanatory or independent variable included in the model. The first is the coefficient which 

indicates the amount of change in the outcome variable occurring with each unit of change in the 

explanatory variable. So, for example, a regression coefficient might tell you how much each additional 

year of education is associated with an increase in income. Coefficients can be difficult to interpret 

rapidly, especially if you have changed the scale (e.g., converted to a log scale), but you should pay 

attention to the direction (positive or negative) of the relationship. There will also be a t-statistic and a 

p-value associated with each independent variable in the model. These are more important. Once again, 

you must check to see if the t-stat value is beyond ±1.96 – and if it is, then you will find a p-value of less 

than 0.05. The further the t-statistic is from zero, the closer the p-value will be to zero – indicating that 

you can be confident that the relationship between the predictive variable and the outcome variable is 

robust and real. Variables that have t-stats close to zero and a p-value greater than 0.05, generally 

should be removed from a model because you cannot be confident the effect on the outcome variable is 

consistent or predictable. 

Multicollinearity can happen when two independent variables are overly correlated with one other. 

Some software packages provide a statistic that warns users of the condition in the model diagnostics 

output. Sometimes multicollinearity is called variable inflation.  

Translating Findings 
A robust and stable model is a powerful tool for understanding complex dynamics that create our 

reality, so being able to explain the model diagnostics in simple terms to stakeholders, the media and 

the public is extremely important. The language used is challenging because it is easy to misspeak and 

for your audience to misconstrue what you report. The section below offers a quick guide to translating 

the jargon of statistical mumbo-jumbo into plain English. 

Adjusted R2 or R2 (depending on the test) – If you multiply Adjusted R2 by 100 then you can say, “this is 

the percent of variation in (dependent variable) explained by the model (or the following factors, listing 

the dependent variables”). For community organizers, the ‘usual suspect’ causal factors, like poverty, 

racism, educational attainment, etc. are already known and accepted by the public as reasons why a 

community may suffer. However, statistical modeling allows researchers to test the effect of a suspect, 

or less well-known, factors in the creation/exacerbation of community suffering. For example, you could 

estimate the effect of liquor stores on crime, or the effect of pollution on test scores. Models allow you 

to estimate the effect of lesser-known variables on community outcomes – while statistically accounting 

for the effects of well-known causal variables. For instance, if your model found that the density of 

liquor stores in a ZIP code was a significant factor in violent crime rates (p =.001), then you could report 

that “Our findings suggest that liquor stores increase violent crime, even while holding constant the 

effect of poverty, ethnicity, age, and other variables known to be associated with elevated crime rates”. 

The same may hold true for variables that are not significant. You may find that the addition of some 

other causal variable does not affect crime (or whatever). You may find that the crime rate does not 

increase by ZIP code (or census tract) with the addition of homeless shelters, or immigrants, or whatever 

because the p-value is greater than 0.05 even after accounting for other, known variables. 

Again, it is not necessary as a community leader to be a statistician or an authority on all data, but it is 

quite useful to be able to communicate intelligently and broadly about a community of interest – and 
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using the languages of statistics, maps, and graphics lends power to your efforts and credibility to your 

words. If you need outside help to gather and analyze data about your community, then with the 

knowledge you have acquired in this short tutorial, you’ll be more confident in your ability to ask logical 

and pertinent questions as you seek to understand and solve community problems.   
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Exercise 5: Calculating Correlation Coefficients – Environmental Data 
In this exercise, you will calculate a series of correlation coefficients that measure the strength and 

direction of association between two variables. You will use data from the CalEnviroScreen to analyze 

the degree and direction of association between pollution data and several socio-economic variables at 

the census tract level in Los Angeles County. 

Student Learning Objectives 

• The student successfully calculates both parametric and non-parametric correlation coefficients 

for data that is at the interval-ratio and ranked scales, respectively. 

• The student correctly interprets the statistical output of the software. 

• The student creates a scatterplot diagram of the correlated variables. 

• The student identifies the value of the statistic in a community advocacy context. 

Objectives 

• Help communities identify their core needs. 

• Help communities identify cause and effect trends evident in data about communities. 

• Research complex issues and recommend evidence-based solutions. 

Instructions: 

1. Open the data in Microsoft Excel.  

Excel File: CalEnviroScreen Data – filtered(xlsx) Click to Download 

| Geography Planet 

2. Examine the data in the tab CES 3.0 and the dictionary in a 

secondary tab. 

3. Note that in the “LA County Only” tab (different from 

what’s in the video) you’ll find pre-prepared data: 

• Only Los Angeles County remains (all others filtered 

out) 

• Missing data, marked with NA (not available) has been filtered out. 

• You should have 2230 rows of data, plus the header row for a total of 2231 rows. 

4. Click on the down arrow next to “Total Population” in cell B1. Check to make sure that all 

census tracts have a minimum threshold of at least 500 persons. Filter out any tracts that 

fall below that minimum to avoid including unusual outliers in the analysis that would cause 

skewing. There should not be any.   

5. Note that each variable has a raw data column (e.g., “Ozone” and a normalized scale version 

“Ozone Pctl”). The scale conversion eliminates the massive skewing that is present in some 

of the columns of data. 

• Recall that you could rank the skewed data as well to reduce the skewing allowing 

you to use Spearman’s Rank Correlation in place of Pearson’s Rank. 

6. Optional: Split your screen. Place your cursor in cell A2 and then click on the View Tab and 

from the options select (click) on the Split button. This allows you to scroll to the bottom of 

the spreadsheet while still seeing the column headers. 

*already done for you* 

Figure 20: Video Tutorial - Calculating 
Correlation Coefficients with Environmental 
Data. URL: https://youtu.be/slyO5X_xSck  

https://geographyplanet.org/learning-resources/tutorials-and-files/cal_enviro_screen_download_filtered/
https://geographyplanet.org/learning-resources/tutorials-and-files/cal_enviro_screen_download_filtered/
https://www.youtube.com/embed/slyO5X_xSck?feature=oembed
https://youtu.be/slyO5X_xSck
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Calculate Correlation Coefficients 

7. Locate the column of data for Asthma Percentile (AN) and scroll to the bottom of the 

column. Place your cursor in the cell two cells below the last observation in the column 

(AN2233 in the filtered file) and type one of the following formulas (they are identical): 

• =CORREL(AN2:AN2231,$AN$2:$AN$2231)   

or 

• =PEARSON(AN2:AN2231,$AN$2:$AN$2231) 

*The data array (block) is the data values for Asthma Percentile. 

* You may want to increase the decimal points visible. 

8. You should get a value of 1.0 because you have calculated the correlation between a 

dataset and itself. If you didn’t get 1.00, then you did something wrong. 

9. Copy the formula to the rest of the cells in that row below each column that has numeric 

values (columns L through BE) 

10. Examine your results. Those are your r values or Pearson’s Correlation coefficient. 

11. You may want to highlight the cells and apply Conditional Formatting (Home toolbar) to the 

correlation coefficients you calculated. 

• Note that the values under the gray columns (percentile scores vs. percentile scores) 

are the ones that are most statistically valid.  

• Note that the correlation between Asthma Percentile and some of the other 

variables are negative…including for some air pollutants (e.g., Ozone Percentile), but 

among the pollutants, Diesel Particulate Matter Percentile is the highest. 

• The data also suggests that there are multiple comorbidities with asthma among the 

health outcome variables – the correlation coefficients are much stronger with 

those. 

12. Repeat the calculation of the correlation coefficient, but this time use the Asthma column 

(AM) of data as the basis of your calculations rather than the Asthma Percentile. Place your 

calculations in the row beneath the first set of correlation coefficients you calculated. 

• Note that the values under the WHITE columns (raw data vs. raw data) are the ones 

that are most statistically valid.  

• Note that the correlation coefficients are slightly diminished in size indicating that 

the percentile scaled data produces higher correlation coefficients. 
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Use the Batch Correlation Tool 

13. Click on the “LA Percentiles Only” tab at the bottom of the 

spreadsheet “Percentiles”. 

• Note that this dataset contains only the percentile 

scores for a select group of variables. 

14. Click on the Data tab and from the Data toolbar tools, 

select the Data Analysis tools (far right button) 

• If the button is not visible follow the instructions in 

Appendix 1. 

15. From the list of data analysis tools, select Correlation and 

click OK. 

16. For the Input Range, highlight the cells you want the tool to consider by highlighting all the 

cells in the data block, including the column headers in row 1. ($A$1:$K$2231) 

17. Check “Labels in First Row” and select where you want the output table to appear (New 

worksheet or perhaps in some rows to the right of your data). Click OK. 

18. Examine your results.  

• You may want to apply conditional formatting to the data values in the output table.  

• Avoid highlighting the values of 1. 

• As you evaluate the results for Asthma, consider the correlation pollutants separate 

from the socio-economic variables. 

• As you evaluate the results for Pop.Char.Pctl. note the stronger correlation with 

Diesel PM percentile. 

Create a Scatterplot Diagram of the Data Showing Correlation. 

19. Return your attention to the Percentiles worksheet. 

20. Click on the Insert tab. 

21. Highlight the first two columns of data (Asthma Pctl and Ozone Pctl) 

22. From the Charts options, click on the “Scatterplot” button (Insert Scatter or X Y or bubble) 

23. From the list of “Scatter” (top left icon) 

24. Click OK and a scatterplot diagram of both variables appears. 

25. Click once on the graphic and note that the data values being visualized are highlighted by 

red and blue outlines outlining each dataset. 

26. Carefully place your cursor on the blue outline surrounding the data in column B – note that 

it changes appearance slightly (the line gets bolder) – when that happens click-and-drag the 

outline box so that it surrounds the values in column D (Diesel PM).  

27. Double click on the graphic. Note that the formula window shows the following data:  

• =SERIES(Percentiles!$D$1,Percentiles!$A$3:$A$2232,Percentiles!$D$3:$D$2232,1) 

• Recall that the correlation coefficient for these two variables was 0.22 

28. Click on your scatterplot diagram to activate the Chart Design tools 

29. Click on the “Add Chart Element” button. 

30. From the list of elements, select “Trendline” and then select “Linear.” 

• Note this is a preview of the regression test you will conduct in the next exercise. 

Figure 21: Video Tutorial - Calculating 
Correlation Coefficients in Excel Using 
Environmental Data. URL: 
https://youtu.be/xTmVToHefYw  

https://www.youtube.com/embed/xTmVToHefYw?feature=oembed
https://youtu.be/xTmVToHefYw
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31. Optional: Double click on the trendline itself to open the “Format Trendline” options. You 

may want to make the trendline bolder (thicker) and a different more visible color or shade. 

32. Experiment with the formatting. 

33. Click on the graphic again and click-and-drag the blue outline over so that you can see how 

the graphic changes as you compare the Asthma data to some of the socio-economic data 

blocks. 

• Note the close correlation between Asthma Percentile and the overall population 

characteristics index “Pop.Char.Pctl” and how the graphic mimics the large 

correlation coefficient you calculated. 

____________________ 

For Credit: Consult with your instructor. Your instructor will likely ask you to submit evidence of your 

competency calculating correlation coefficients using the two techniques demonstrated in these 

instructions, as well as your ability to create one or more scatterplot diagrams. 

You are also likely to be asked to submit this evidence alongside a half-page of text in which you provide 

evidence that you understand what the statistical output indicates (r in this exercise) as well as evidence 

that you understand the value of this statistical calculation for advancing community health and well-

being. 

 

Data Source: California Office of Environmental Health Hazard Assessment 

CalEnviroScreen 1: https://oehha.ca.gov/calenviroscreen/maps-data 

CalEnviroScreen 2: https://oehha.ca.gov/calenviroscreen/report/draft-calenviroscreen-40 

 

  

https://oehha.ca.gov/calenviroscreen/maps-data
https://oehha.ca.gov/calenviroscreen/report/draft-calenviroscreen-40
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Exercise 5B: Analyzing the Effect of Fast-Food Accessibility on Childhood 

Fitness Levels in Los Angeles with Regression Modeling. 
Background 

Regression or Data Modeling is the most powerful type of statistical tool commonly used by social 

scientists. It allows the curious to create from existing data a hypothetical estimate of cause and effect 

occurring between an outcome variable and one or more causal variables. 

In this exercise, you will create a linear regression model that estimates the effects of a handful of 

neighborhood conditions on the level of childhood fitness in Los Angeles County using ZIP codes. You 

will learn how to run the regression tool in Excel and read the diagnostic output created by the 

software. 

Student Learning Objectives 

• The student successfully builds a data model using Excel’s regression tool using health and 

environmental data. 

• The student correctly interprets the model diagnostics output produced by the software. 

• The student explains the value of data modeling in a community advocacy context. 

Objectives 

• Help communities identify their core needs. 

• Help communities identify cause and effect trends evident in data about communities. 

• Research complex issues and recommend evidence-based solutions. 

Instructions: 

1. Open the Excel file in Microsoft Excel. 

Excel File: Fast Food Fitness Data for Regression(xlsx) Click to 

Download | Geography Planet 

2. Familiarize yourself with the data. Note that the dependent 

variable that we seek to predict, explain, or model is in 

column C, with the column header “Fitness Pct”. It 

represents an estimate of the percentage of 5th graders 

who are in the “healthy fitness zone” based on tests 

conducted in school within and near each ZIP code. 

3. Note that data in the gray columns are demographic characteristics of the neighborhood, 

and the yellow columns are ethnic characteristics, the orange columns are educational 

attainment variables, and the green columns contain income/employment data. 

4. Most of the data is either ratio or percent data, so most variables are on the same scale, or 

at least a similar one. The exceptions include income, age, household, total population, and 

the counts of various businesses. 

5. Note that the eight columns on the far right (blue) contain landscape variables.  The light 

blue columns have the number of food establishments, and the dark blue rows contain a 

measure of the density of each type of business as a location quotient. 

Figure 22: Video Tutorial -Data Modeling 

URL: https://youtu.be/SEH6A_ynjnA   

https://geographyplanet.org/learning-resources/tutorials-and-files/fastfood_fitness_regresssion/
https://geographyplanet.org/learning-resources/tutorials-and-files/fastfood_fitness_regresssion/
https://en.wikipedia.org/wiki/Economic_base_analysis
https://www.youtube.com/embed/SEH6A_ynjnA?feature=oembed
https://youtu.be/SEH6A_ynjnA
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6. Place your cursor in cell C246, two rows below the last data entry for “Fitness Percent” and 

enter the following formula: =SKEW.P(C2:C244) to calculate the level of skewness in column 

C of data.  You may want to increase the number of decimal points evident in the cell. The 

value should be 0.227. 

7. Copy the formula and paste it in all the cells in the rest of the row, so that you have 

calculated the level of skewness for columns C – Y. 

8. Examine your results – look for values above 3.0. 

9. Next, calculate Pearson’s correlation coefficient for Fitness Percent and all the other 

variables. Begin by entering the following formula: =CORREL($C$2:$C$244,C2:C244). You 

should get a value of 1.000 (increase the decimal if you need) 

10. Copy that formula (make sure the $ are in the formula!) to the rest of the cells in the row, so 

that you have a correlation coefficient between Fitness Percent and all the data in columns 

D to Y. 

11. You may want to apply conditional formatting to the cells (red-white-blue) to highlight the 

especially large correlation coefficients. Remember that positive and negative values are 

equally important. 

• This step helps us identify variables that are likely to be significant contributors to 

our predictive model (our estimation of fitness levels) 

• It’s not always necessary to include this step and rigid adherence to the numbers as 

a guide may occasionally invite you to exclude a worthy variable, so caution is 

advised. 

• It is also very likely that you will be able to identify variables that measure the same 

condition (e.g., median income and housing value = wealth) that may require you to 

eliminate one or more redundant variables from consideration because of excessive 

multicollinearity (variable redundancy). 

12. Select at least 5 and as many as 7 variables that you think are likely to be causal factors in 

the fitness levels of children. Be sure to include at least two of the location quotient 

variables. 

13. Copy the entire data block (you may include the calculations at the bottom) and paste it into 

a new worksheet ply (click on a plus sign at the bottom of the worksheet to generate a new 

blank worksheet) 

14. In your new worksheet, click on the column header D above the “Total Pop” in cell D1 and 

drag to the right until you have highlighted 7 or 8 columns of data.  

15. Click on the Insert button (Home toolbar) and you should have a series of blank columns of 

data.  

16. Copy columns of data associated with your selected candidate variables and paste them one 

or two at a time into the blank columns.  

• The goal is to have from 5 to 7 columns of data, containing 3 to 7 candidate 

variables that you consider likely to be partially responsible (associated with) the 

varying levels of childhood fitness. 

• They should be arranged so the columns of dependent variables are adjacent to the 

column “Fitness Pct” and adjacent to one another forming a solid data block. 
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• Here are some good candidates to start with:  

• Avg HH Size 

• PctBrwn (or PctWhite) 

• PctNOHS (or PctBA) 

• Median Inc 

• LQFF10 (or LQSPM10, etc.) 

Run the Data Model 

17. Click on the Data tab and click on the Data Analysis button on 

the far right of the Data toolbar. 

• If the button is not visible follow the instructions in 

Appendix 1. 

18. From the Data Analysis tool options, select Regression. Click 

OK. 

19. The Regression tool will prompt you to identify the range of 

data containing the dependent or Y variable and the X, 

independent or causal variables, along with some model 

specifications.  

20. Enter the data as it appears in the figure at right.  

• Note that the Y Range includes the “Fitness Pct” data. 

• Note that the figure at right is assuming 5 columns of 

data (D-H), so if you include fewer or more 

independent variables in your analysis, your entry into 

the “Input X Range” box will look different. 

• Check Labels on. 

• Place a check in the Confidence level box and leave it 

at 95. 

• Since this is your first model, you can name the new 

worksheet ply “Model 1” 

• Check Residuals and Standardized Residual 

21. Click OK and examine your model diagnostics. 

Read the Model Diagnostics 

*Adjusted R Square = .591 indicating 

the independent variables are 

explaining/predicting about 60% of 

the variation in the dependent 

variable (fitness percent) – this is the 

“model fit” and it’s strong. 

*F statistic = 71 (very high) and 

significance below .05 (3.23 *10-45)– 

indicating great confidence in the 

Figure 23: Video Tutorial - Regression 
Modeling with Excel, Part 2. URL: 
https://youtu.be/pSlxv5zlUYQ  

Figure 24: Dialog Box for Regression 
Tool. 

Figure 25: Model Diagnostics Output. 

https://www.youtube.com/embed/pSlxv5zlUYQ?feature=oembed
https://youtu.be/pSlxv5zlUYQ
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overall robustness of the model – this value is so high because there are 243 ZIP codes in the 

analysis, making us very sure of our results (green outline in Figure 25). 

*t-stat and p-value (red outline in Figure 25) for some variables are good. Two of them fall below 

the confidence threshold. The t-stat for Avg HH (household) Size is -0.43, and its p-value is 0.66, 

indicating that it is not a significant factor in childhood fitness. The t-stat for LQFF10 is just below 

1.96, and so it would not be significant at the 95% (.05) level, but it would be at the 90% (.10) level, 

so it’s worth keeping. The others, including Pct Brown (t=-7.64); PctNOHS(t=2.99) and MedianInc (t 

=4.59) are all significant (p < 0.05), so they should remain in consideration for future refinement of 

the model. 

* The residuals are the difference between the value 

for Predicted Fitness Percent and the observed Fitness 

percent. For observation 1 (ZIP 90001), the actual 

fitness percent was 50.78 and the model predicted it 

should be 52.459 – the difference (residual) = -1.67, 

and the Z-score is expressed as the standardized 

residual = -0.2782. That was a pretty good prediction 

for that ZIP code 90001. 

*the list of residuals and standardized residuals can 

be sorted and examined for outliers – ZIP codes that do not conform well to the model prediction / 

best-fit line. If you made a histogram of the residuals, you’d see a very normal distribution (bell 

curve). It is useful to examine the outliers (Standard Residual > 2) to analyze the conditions present 

in those observations to see if they should remain included in the model. Sometimes you must 

remove a ZIP code (or observation) because it represents a very unusual circumstance (e.g., 

Universal Studios has its own ZIP codes -but probably should be eliminated from any model of 

crime, health, education, fitness, etc.). 

Experiment!   

You’ll find that certain combinations of variables work better than others to build a model that has 

a good fit and robust explanatory power. 

_________________________ 

For Credit: Consult with your instructor. Your instructor will likely ask you to submit evidence of your 

competency in building a simple regression data model using the supplied data, as well as your ability to 

identify model outliers by their residual values. 

You are also likely to be asked to submit this evidence alongside a half-page of text in which you provide 

evidence that you understand how to interpret the model diagnostics output. 

You should be able to explain the meaning of the Adjusted R square value, the F and F significance 

indicators, as well as the t-stat and the p-values for each of the models' dependent (x) variables. 

Figure 26: Residual Output Table. 
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Finally, you should include a paragraph explaining the value of creating a regression data model as a tool 

for advancing community health and well-being. 

 

Data Source: California Office of Environmental Health Hazard Assessment 

CalEnviroScreen 1: https://oehha.ca.gov/calenviroscreen/maps-data 

CalEnviroScreen 2: https://oehha.ca.gov/calenviroscreen/report/draft-calenviroscreen-40 

 

  

https://oehha.ca.gov/calenviroscreen/maps-data
https://oehha.ca.gov/calenviroscreen/report/draft-calenviroscreen-40
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Appendix 1: How to Install the Data Analysis ToolPak in Microsoft Excel 

 
Click the File tab, click Options, and then click the Add-Ins category. 

If you're using Excel 2007, click the Microsoft Office Button, and then click Excel Options. 

In the Manage box, select Excel Add-ins, and then click Go. 

If you are using Excel for Mac, in the file menu go to Tools > Excel Add-ins. 

In the Add-Ins box, check the Analysis ToolPak check box, and then click OK. 

If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. 

If you are prompted that the Analysis ToolPak is not currently installed on your computer, click Yes to 

install it. 

Note: To include Visual Basic for Application (VBA) functions for the Analysis ToolPak, you can load the 

Analysis ToolPak - VBA Add-in the same way that you load the Analysis ToolPak. In the Add-ins available 

box, select the Analysis ToolPak - VBA check box. 

You may want to consult YouTube to find a video on how to complete these steps. There are a lot of 

them. Here’s one that seems good: https://youtu.be/V60-IFnih3Q 

  

https://youtu.be/V60-IFnih3Q
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Appendix 2: Data Links (2021) 
Federal 
US Census Bureau – Data Portal 

State of California 

Tax Data 

Personal Income Tax Statistics by Zip Code - Personal Income Tax Statistics by Zip Code - California Open 

Data 

https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-

aa44-6e0c6f49c9c1 

Unemployment 

Local Area Unemployment Statistics (LAUS) - Datasets - California Open Data 

https://data.ca.gov/dataset/local-area-unemployment-statistics-laus 

Education 

Data & Statistics (CA Dept of Education) 

https://www.cde.ca.gov/ds/ 

https://dq.cde.ca.gov/dataquest/ 

CBEDS Data about Schools & Districts - Student & School Data Files (Downloadable) (CA Dept of 

Education) or https://www.cde.ca.gov/ds/sd/sd/filescbedsorab.asp 

One-Year Graduate Counts - Student & School Data Files (Downloadable) (CA Dept of Education) 

Or https://www.cde.ca.gov/ds/sd/sd/filesoygrads.asp  

Local – Southland Region 
The Los Angeles City Data Portal  

Los Angeles County’s data portal 

 

  

https://data.census.gov/cedsci/
https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-6e0c6f49c9c1
https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-6e0c6f49c9c1
https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-6e0c6f49c9c1
https://data.ca.gov/dataset/personal-income-tax-statistics-by-zip-code/resource/7091fcca-e695-49ab-aa44-6e0c6f49c9c1
https://data.ca.gov/dataset/local-area-unemployment-statistics-laus
https://data.ca.gov/dataset/local-area-unemployment-statistics-laus
https://www.cde.ca.gov/ds/
https://www.cde.ca.gov/ds/
https://dq.cde.ca.gov/dataquest/
https://www.cde.ca.gov/ds/sd/sd/filescbedsorab.asp
https://www.cde.ca.gov/ds/sd/sd/filescbedsorab.asp
https://www.cde.ca.gov/ds/sd/sd/filescbedsorab.asp
https://www.cde.ca.gov/ds/sd/sd/filesoygrads.asp
https://www.cde.ca.gov/ds/sd/sd/filesoygrads.asp
https://data.lacity.org/
https://data.lacounty.gov/
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Appendix 3: CalEnviroScreen Download 
1. Go to Cal Enviro Screen  

https://oehha.ca.gov/calenviroscreen 

2. Click on Maps and Data 

3. Click on Download Data 

4. For this exercise, click on Microsoft Excel Spreadsheet 

https://oehha.ca.gov/media/downloads/calenviroscreen/document/ces3results.xlsx 

https://oehha.ca.gov/calenviroscreen
https://oehha.ca.gov/media/downloads/calenviroscreen/document/ces3results.xlsx
https://oehha.ca.gov/media/downloads/calenviroscreen/document/ces3results.xlsx
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